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Abstract—The paper presents applications in Excel 2010 that are 

implemented in economic activity in the modern society of today 

and tomorrow.  If you have planned the distribution of goods 

from production to consumption we use transport problems. As 

we know linear programming represents a method of problem 

solving decision problems. It presented also an allocation 

problem that it can occur in various decision-making situations 

like: allocation works on machines, assignment of personnel in 

various regional centers, distributions agents to perform certain 

activities. Many real-life projects are complex and expensive and 

their production on time and within budget is not of any task. 

Typical certain activities cannot start before the other to finish. 

Decision problems containing uncertainty is not known when the 

likelihood of states of nature. These problems can be addressed in 

several ways, and accordingly there are several decision criteria. 

Because it by applying various criteria can get different advice is 

good decision agent to understand very well the existing criteria 

and to select the one that fits best, adverse to the best gain. In 

conclusion it presented application for: regret criterion, optimist 

criterion and pessimist criterion. It presented decisional analysis 

problems using solver. In Microsoft Excel 2010 are available a lot 

of categories of functions like: functions or type date and time, 

financial functions, logic functions, mathematical and 

trigonometric functions, statistical functions, database functions, 

external functions, engineering functions and user-defined 

functions. It also presented charts, applications with scenarios, 

goal seek, solver, pivot table and lists.  

Keywords-component: solver, pivot tables, lists, charts, 

scenarios, allocation problem, project management, data and time 

functions, financial functions, logic functions, mathematical and 

trigonometric functions, statistical functions, database functions, 

engineering functions, user-defined functions 

I. INTRODUCTION 

 

There are a lot of problems from economic activity that I 

presented in this article. Microsoft Office Excel 2010 has a lot 

of new functions and new facilities like the others versions of 

Microsoft Office Excel and is easy to use to create charts, 

reports, statistical analysis, problems of operational researches 

and so on.  

II. TROUBLESHOOTING TRANSPORTATION 

 
Transport problems occur frequently in a position where 

you have planned the distribution of goods from production to 
consumption. Common objective of the problems is to 
minimize transportation costs. Transport models are a variation 
of linear programming problems involving the following: 

1. The objective is to minimize transport problems in 
transport costs; 

2. Transport costs are linear functions in relation to the 
number of units shipped; 

3. Supply and demand are expressed in homogenous units; 

4. Transport costs per unit do not vary with the transported 
quantity. To illustrate how you can solve transport problems we 
present the following example. A company has three factories 
and four distribution centers. The factories are located in Cluj, 
Bacau, and Craiova.  

TABLE I. THE CAPACITY OF PRODUCTION (UNITS) 
OF THE FACTORIES 

Factory The capacity of 
production(units) 

Cluj 5000 

Bacau 6000 

Craiova 2500 

Total 13500 

 

      Distribution centers are located in Deva, Iasi, Bucharest and 
Brasov. Demand in this centers is: 

TABLE II. DEMAND(UNITS) IN CENTERS OF 
DISTRIBUTIONS 

Center of distribution Demand(units) 

Deva 6000 

Iasi 4000 
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Bucharest 2000 

Brasov 1500 

Total 13500 

 

The management would like to determine the amount that 
should be shipped from each plant to each distribution center so 
transport costs to a minimum. 

The following figure shows the graph of 12 possible routes. 
Such a graph is called the graph of the network. Circles 
represent nodes. Lines joining nodes are called arcs. 

Each point of departure and arrival is represented by a node 
and each possible route is represented by an arc. The right of 
each node is last bid amount (for production capacity) and 
demand (for distribution centers). Direction of travel is 
indicated by arrows. Transport unit costs for each route are 
presented in the following table, on each spring following 
figure: 

 

TABLE III. UNITS TRANSPORT COSTS ON EACH 
ROUTE 

Destination 

Origin 1.Deva 2.Iasi 3.Bucharest 4.Brasov 

1.Cluj 3 2 7 6 

2.Bacau 7 5 2 3 

3.Craiova 2 5 4 5 

 

 

To solve the problem of transport I use the linear 
programming. I have two indices decision variables the first 
index indicates the origin node, the second node destination. 

Thus ijx  denote the number of units shipped from the 

factory i   and distribution center j  . 

The unit cost carried from Cluj is: 

11 12 13 143* 2* 7* 6*x x x x     (1) 

The unit cost carried from Craiova is: 

31 32 33 342* 5* 4* 5*x x x x    (2) 

The sum of these costs is the total cost of transportation, 
value to be minimized, so the objective function is: 

11 12 13 14 21 22 23 24

31 32 33 34

min(3* 2* 7* 6* 7* 5* 2* 3*

2* 5* 4* 5* )

x x x x x x x x

x x x x

       

  

 (3) 

 

Restrictions on transport issues arise because each factory 
has a certain capacity of production. Cluj factory has a 
production capacity of 5000 units. The total number of the units 
shipped from the factory in Cluj is: 

11 12 13 14x x x x   , so that the factory has like 

associated restriction 

11 12 13 14 5000x x x x     (4) 

Similarly for the other factories we have: 

21 22 23 24 6000x x x x     (5) 

for the factory from Bacau 

31 32 33 34 2500x x x x    (6) 

for the factory from Craiova 

      In the other four distribution centers, the restriction will be 
on that request at the center must be equal to the amount 
transported there. 

11 21 31 41 6000x x x x    (7) 

Demand in Deva   

12 22 32 42 4000x x x x    (8) 

Demand in Iasi 

13 23 33 43 2000x x x x    (9) 

Demand in Bucharest 

14 24 34 44 1500x x x x    (10) 

Demand in Brasov 

 Combined objective function with the constraints we 
obtain the transport model: 

11 12 13 14 21

22 23 24 31

32 33 34

11 12 13 14

21 22 23 24

31 32 33 34

11 21 31 41

12 22 32 42

13 23 33 43

14

min(3* 2* 7* 6* 7*

5* 2* 3* 2*

5* 4* 5* )

5000

6000

2500

6000

4000

2000

x x x x x

x x x x

x x x

x x x x

x x x x

x x x x

x x x x

x x x x

x x x x

x

    

  

  

   

   

   

   

   

   

 24 34 44 1500

0; 1,2,3; 1,2,3,4;ij

x x x

x i j

  

  

 

(11) 

Solving problems in Excel-the spreadsheet used to solve the 
problem is shown in the following figure: 
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Figure 1. Modelling transport problems 

Data of the problem are introduced in the domain A1:F8. 
The transport costs are contained in the B5:E7, production 
capacity (supply) F5:F7, and demand distribution centers in 
cells B8:E8. 

Key elements to be included in Excel are decision variables. 
Initially all decision variables have the value 0. 

Objective function: To calculate the total cost in cell 
C13=SUMPRODUCT(B5:E7,B17:E19). 

The left side restrictions F17:F19 cells contains formulas 
left –restrictions associated demand distribution centers, 
formulas used are: Cell F17=SUM(B17:E17). It copies itself to 
F18 and F19. 

Cell B20=SUM(B17:B19). B20 is copied to C20:E20.0 

Right side restrictions, cells H17:H19 contain restriction on 
the right side associated demand distribution centers. 

These values are already introduced in the initial data of the 
problem, so it will use the formulas: Cell H17=F5. It copies 
itself to H17 in H18:H19. 

Cell B22=B8. B22 is copied into C22 and E22. It solves the 
problem using the Solver. Dialog solver Parameters box is 
completed as in the following figure. Selected options are 
Assume   Linear Model and Assume Non-Negative.  

 

Figure 2. Solver Parameters of Modelling transport 
problems with SIMPLEX LP 

The optimal solution shows that the minimum cost of 
transport is 39500 monetary units and in field B17:B19 are 
displayed quantities to be transported on each route. A value of 
0 indicates that the route didn‟t carry anything 

Variations of transport problems 

Total supply is equal to the total demand. In many cases the 
total supply is equal to the total demand. Excess supply will 
appear as a deviation in the solution of the problem, and the 
deviations can be constructed to offer unused or quantities not 
transported. If total supply is less than total demand 
programming model linear transport problem has a feasible 
solution.  

To solve the problem creates a fictional so that its offer to 
satisfy excess demand and transportation costs awarded in this 
0. In this way the linear programming problem will have 
solutions. 

Maximize the objective function 

In some problems the goal is to find a solution that 
maximizes revenue or income, or profit. Using unitary income 
or profits in the objective function coefficients will solve a 
problem of minimization rather than a problem of 
maximization. The changes do not affect restrictions. 

Unsupported routes 

Establishing a route from every origin node to every 
destination node is not always possible. 

Routed with limited capacities 

Four routes with limited additional restrictions are 
introduced. For example, if transport route Craiova-Deva 
cannot carry more than 1000 units will be introduced the 

restriction 13 1000x  .  

The general model of a linear programming transportation 
problem with m  points of origin and destination  n  points is: 



 International Journal of Computer and Information Technology (ISSN: 2279 – 0764)  

Volume 02– Issue 05, September 2013 

 

www.ijcit.com    1029 

 

III. LINEAR PROGRAMMING 

Linear programming represents a method of problem solving 
decision making. The following applications are specific to 
their resolution using linear programming: 

1. A manager must establish a program for the next period 
production and inventory levels so as to be satisfied market 
demand and also wants to minimize the total cost of production 
and storage costs. 

2. A financial analyst must select for a portfolio of 
investments the best combination of stocks and bounds. These 
investments should be selected so as to maximize investment 
efficiency. 

3.  Inner making manager must determine how to distribute 
the budget for advertising in different media: newspapers, 
television, radio and magazines so that the effect of advertising 
to be made up. 

4. A company has warehouses in several cities in the 
country and receives orders from customers in various 
locations. The question of determine amounts to be sent from 
the warehouse so that the total transport costs to be minimized. 

These are few examples where linear programming has 
been used successfully, but the list goes on. What these 
examples have in common is that they try to minimize or 
maximize something. 

In the first example the manager wants to minimize 
investment efficiency. In the third example marketing manager 
must maximize advertising effectiveness. In the fourth example 
should be minimized transportation costs. In all linear 
programming problems the objective is to maximize or 
minimize some quantities. 

All linear programming problems have a second property: 
restrictions that limit the degree to which the goal can be 
achieved. In the second example the analyst is limited to the 
amount and types of shares existing available. 

In the third example the marketing director is constrained 
by fixed budget and availability of advertising media. 

In the fourth example the quantities that can be transported 
are limited to availability in each store.  

In conclusion, the restrictions are another general feature of 
each linear programming problem.  

The ABC firm produces a variety of chemicals. In a 
production process to produce two products (additive and 
solvent) required three types of raw materials. The additive is 
sold to oil mils and it is used in the production of various types 
of fuel. The solvent is selling chemical plants and it is used in 
the manufacture of detergents. Additive and solvent to produce 
three materials are mixed in the proportion indicated in the 
table: 

TABLE IV. MIXING BETWEEN ADDITIVE AND 
SOLVENT 

Material The first product The second 
product 

 additive solvent 

First material 0.4 0.5 

Second material 0 0.2 

Third material 0.6 0.3 

 

    To get a tone of additive mix 2/5 tons of material 1 and 1/5 
tons of materials two and 3/10 tons of materials 3. 

     The production is limited to the availability of the three 
materials. Currently the company has 20 tons of material 1, 1.5 
tons of material 2 and 21 tons of material 3. The nature of 
production process, raw materials are used in the current 
production and are considered waste. 

     Each tone of additive brings a profit of $40 per ton of 
solvent and makes a profit of   $30. ABC management, as 
market demand analysis, decided that the price set will 
determine the entire amount of product sales (additive and 
solvent).  

     Problem formulation and modeling is the process of 
transposing the problem into a mathematical model. Modeling 
is an art that can be mastered through practice and experience.             
Although each problem has unique characteristics, many 
problems has unique characteristics, many problems can have 
common features. Therefore, for beginners can be useful a set 
of rules, that can be applied to formulate a model of which may 
be illustrated in the development of a mathematical model for 
ABC company. 

    The first step is to identify the objective and constraints. In 
our case the objective is to maximize the total profit. 
Restrictions relate to the quantities of raw available materials, 
which limit the amount of additive and solvent that can be 
produced. 

    Restriction 1: the quantity of material 1 used must be less 
than or equal to the amount of material one available. 

    Restriction 2: the amount of material 2 used must be less 
than or equal to the amount of material available 2. 

    Restriction 3: The amount of material 3 used must be less 
than or equal to the amount of material available 3. 

    The next step is to define the decision variables. The two 
decision variables are: the number of tones of additive products 
and the number of tones of solvent products. We denote by: 

-A=additive quantity produced (tons); 

-S=solvent quantity produced (tons); 

-A and S are decision variable 

   It is written using objective decision variables. The total 
profit comes from two sources: sales of solvent and sales of 
additive. If the profit made by selling a tone of additive is $40, 
then profit by  

   Selling tons of A will be 40*A. 

   Similarly, if the profit made by selling a ton of solvent is $ 
30, then profit by selling tons of S will be 30*S. 

40* 30*Total profit A S   (12) 

   Mathematical expression of the objective function is called 
objective. 

   If our objective is to maximize the total profit, then the 
objective function will be: 

(40* 30* )Max A S (13) 
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   Restrictions are written using decision variables. Restriction 
1: Because a ton of additive is produced from 2/5 tons of 
material 1, the amount of material needed to produce 1 ton of 
additive A is 2/5*A. For each ton of solvent using ½ tons of 
material 1, so that the amount of material  needed to produce 
one tone of solvent S is ½*S. 

   Total objective and constraints were transformed into a set of 
mathematical relationships, set of relationships defined as the 
mathematical model. Complete mathematical model of the 
problem is: 

(40* 30* )

2 / 5* 1 / 2* 20

1 / 5* 5

3 / 5* 3 /10* 21

0

0

Max A S

A S

S

A S

A

S


  





 
 




 

(14) 

   -for solving optimal combination must be found(the A and S) 
that satisfy all constraints and also lead to an objective function 
value that is greater or equal than any value calculated with 
another possible solution. 

   If that the objective function and restrictions are linear 
functions with respect to the decision variables (decision 
variables appear only at the power one), then we have a linear 
programming problem. 

   Note that the spreadsheet is composed of two parts: 

   -the first part containing the problem; 

   -the other contains the model; 

   One advantage of separating data model is that can be studied 
effort to change the input measurements model using only 
changes in this area that contains data. 

   Another advantage is that the analyst can develop 
independently of available data model. 

   Step 1: Entering Data Problem 

   The problem appears at the top of the spreadsheet. 
Composition to obtain fractions representing one ton of solvent 
and additive were converted into decimal values and placed in 
the B5:C7. 

   The value 0.4 from cell B5 shows that every tone of additive 
product uses 0.4 tons of material 1, the value 0.5 from cell C5 
shows that each tone of solvent produced using 0.5 tons of 
material 1, etc. Cells D5:D7 contains the available quantity of 
each material, and the cells B8 and C8 contain the profit made 
by selling or calculating the objective function one of additive 
($40) or solvent ($30). 

   Step 2: Define cell which will contain the decision variables. 
B15 and C15 cells contain the number of tons of additive and 
solvent products. 

   Step 3: Define the objective function cell containing the 
formula. 

   Cell B17 contains the formula for calculating the objective 
function=B8*B15+C8*C15 (the unit profit per ton of additive 

*production of additive +the unit profit per ton of 
solvent*production of solvent). 

   Step 4: Defining cells that contain formulas on the left of 
restrictions. 

   Cells B20:B22 contain formulas that show how to calculate 
the left side of restrictions. For the material 1, in cell B20 
introduce the formula=B5*B15+C5*C15 (the quantity of 
additive produced*the quantity of material one to produce a ton 
of additive + the quantity of solvent produced *the quantity of 
material 1 to produce a ton of solvent). 

   Similarly we enter formulas in cells B21 and B22 for 
materials 2 and 3. 

   Step 5: Defining cells that contain the values from the right 
side of restrictions. 

   Spreadsheet used to solve the problem. 

 

Figure 3. Linear Programming-Problem with additive and 
solvent 
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Figure 4. Solver for Linear Programming-Problem with 
Additive and Solvent 

 

 

   In the problem analyzed the values from the right of 
restrictions represents the amount of material available, values 
that are already placed in the D5:D7. 

   For material 1, in cell D20 enters the formula=D5 is for 
material 2 in cell D21 enter the formula=D6 themselves and for 
material 3 in cell D22 to enter the formula=D7. 

   An advantage of using spreadsheet is that if one of the values 
that contains the problem changes, the model values 
automatically change. 

   To determine the optimal solution of the problem we will use 
the SOLVER from Excel. The following steps show how 
SOLVER can be used to obtain the optimal solution for a linear 
programming problem. 

1. Select the MENU TOOLS. 

2. Apply the SOLVER Command. 

3. SOLVER Parameters box is filled in the following 
manner: 

->Set Target Cell: B17; 

->Select the option MAX; 

->By changing Cells: B15:C15; 

->Select ADD button; 

4.    Add Constraint box is completed as follows: 

->Cell Reference: B20:B22; 

->Select Operator<^  ; 

->Select the OK  button  ; 

5. When the tape SOLVER PARAMETERS reappear 
SELECT the OPTIONS button. 

6.   SOLVER OPTIONS is selected in the box: 

->ASSUME LINEAR MODEL; 

->ASSUME NON-NEGATIVE; 

->Button OK; 

7.  When the tape SOLVER PARAMETERS reappear 
select button SOLVENT; 

8.  Results in Box SOLVER Select Keep SOLVER 
Solution.  Select the OK button to generate the optimal 
solution, displayed in cells B15, C15. 

9.   The optimal solution is 25 tons of additive and 20 tons 
of solvent. 

IV. ALLOCATION PROBLEMS 

Allocation problems can occur in various decision-making 
situations. Typical problems are: allocation works on machines, 
assignment of personnel in various regional centers, 
distribution agents to perform certain activities. 

A distinguishing feature is that the agent is assigned a 
single task and tries optimizing an objective, such as 
minimizing costs, maximizing profit. 

To illustrate how to solve allocation problems we consider 
the following example: 

The company ABC specializing in market research has 
three new clients. Each project must be assigned then a project 
leader. The time required for the project depends on the 
experience and ability of project leader. Currently available 
only three projects have about the same priority and cannot be 
achieved simultaneously. The management company must 
establish the project leader will coordinate each trial so that 
three studies to finish in the shortest total time. A leader can be 
assigned to only one project. Three clients and three studies are 
alternatives. The estimated time to complete each project is 
presented in table 1: 

TABLE V. ESTIMATED TIME FOR COMPLETION OF 
EACH PROJECT 

Project 
Leader 

Client 1 Client 2 Client 3 

Ionescu 10 15 9 

Popescu 9 18 5 

Georgescu 6 14 3 

 

Network graph for the problem analyzed 

   Nodes correspond project leaders and clients, and the springs 
are possible distribution of the client project leaders. 
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Figure 5. Network graph attached to allocation problem 

   Offer each origin node 1 and demand in each destination 
node is 1. Distribution cost of a customer project leader is the 
time required for the study. Note the similarity if the issues and 
the allocation of transport allocation problems is a special case 
of transportation problem where all packages and applications 
have value 1 and the amount carried on each arc is 0 or 1. 

   The problem can be solved using linear programming 
method. We need a variable for each arc and each node 

restriction. We use two indices decision variables ijx  -sharing 

and the project leader j  . 

   In conclusion we will have nine variables of decisions. 

1,

0,

1,2,3 1,2,3.

ij

if the leader i is distributed to client j
x

in the other cases

wherei and j


 


 

 

(15) 

   Using these notations: 

   The necessary time needed to complete projects by Ionescu 
is: 

11 12 1310* 15* 9x x x    (16) 

   -only one of decisions variables can take the value 0; 

   The necessary time needed to complete projects by Popescu 
is: 

21 22 239 18* 5*x x x    (17) 

   -only one of decisions variables can take the value 0; 

   The necessary time needed to complete projects by 
Georgescu is:  

31 32 336* 14* 3*x x x  (18) 

   -only one of decisions variables can take the value 0; 

   The sum of these times gives the number of days to complete 
the three market studies. Thus the objective function is: 

11 12 13 21 22 23 31 32 33(10 15* 9* 9 18* 5* 6* 14* 3* )Min x x x x x x x x x         

(19) 

  Restrictions reflect the fact that each leader can be assigned at 
most a client and each client must be assigned a leader. These 
restrictions are: 

11 12 13 1x x x   (20) 

-ineq. (20) it represents distribution of Ionescu; 

21 22 23 1x x x   (21) 

-ineq. (21) it  represents distribution of Popescu; 

31 32 33 1x x x    (22) 

-ineq. (22) distribution of Georgescu; 

11 21 31 1x x x   (23) -client 1 

12 22 32 1x x x    (24)-client 2 

13 23 33 1x x x    (25)-client 3 

   Combining objective function with constraints we get: 

11 12 3 21

22 23 1 32 33

11 12 13

21 22 23

31 32 33

11 21 31

12 22 32

(10* 15* 9* 9*

18* 5* 6* 14* 3* )

1

1

1

1 1

Min x x x x

x x x x x

x x x distributionof Ionescu

x x x distributionof Popescu

x x x distributionof Georgescu

x x x client

x x x

  

    

   

   

   

   

  

13 23 33

1 2

1 3

0 1,2,3 1,2,3ij

client

x x x client

x for i and j



   

  

 

(25) 

 

 

Figure 6. Worksheet attached to the problem 

   Data of the problems are introduced in the domain: A1:D7.  

   Decision variables cells D16:D18 are reserved decision 
variables. Initially all decision variables have the value 0. 
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   Objective function-the formula 
SUMPRODUCT(B5:D7,B16:D18) were placed in cell C12 to 
calculate the number of days needed to complete all projects.  

   The left part of restrictions – 

   Cells E16:E18 containing restriction left on the number of 
clients that can be assigned a leader. 

   Cells B19-D19 contain restriction left by which a project 
must be assigned them a project leader. 

   The formulas used are: 

   -Cell E16=SUM(B16:D16). It copies itself into E17:E18. 

   -Cell B19=SUM(B16:B18). It copies itself into C19:D19. 

   Right side restrictions, cells G16:G18 contain restrictions on 
the right side of leaders and cells B21:D21 contain restrictions 
on the right of customers. 

   All values are equal to one. 

   The parameters are completed as shown next. Selected 
options are ASSUME NEGATIVE LINEAR MODEL and 
NON ASSUME. 

 

Figure 7. Box Solver Parameters 

   Optimal solution to the problem is : Ionescu is assigned to 
client 2,  Popescu is assigned to client 3 and Georgescu is 
assigned to client 1. Time completion of the three projects is 26 
days. 

Variations of the problem 

 

   Because allocation problems can be treated as special cases 
for transport, variations that can occur in allocation problems 
are the same as in transport issues. 

   The total number of agents (offer) is different from the 
number of activities (application). 

   If the number the agents it exceeds the number of activities, 
additional agents will remain unallocated linear programming 
model. 

   If the number of activities is greater than the number of 
agents linear programming model will have a feasible solution. 

   In this case just add a sufficient number of agents to be equal 
to the number of activities. The objective function coefficients 
for fake agencies will be zero. 

   If allocation problems are evaluated in terms of revenue and 
profit we have to solve a problem of maximizing instead 
minimizing. 

   In addition, if one or more allocations will not be accepted 
decision variables will be removed from linear programming 
model. 

   For the example this may occur if an agent does not the 
necessary experience to work on a project. 

   Not make changes to the spreadsheet, the simplest solution is 
attaching high costs for the decision variables corresponding 
allocations that cannot be accepted. 

   The general model for the allocation problems is: 

1 1

1

1

1 1,2, ,

1 1,2, ,

0

m n

ij ij

i j

n

ij

j

m

ij

i

ij

Min c x

x i m Agents

x j n Activities

x for all i and j

 







 

 













 

(26) 

 

V. PROJECT MANAGEMENT 

   Many real-life projects are very complex and expensive and 
their production on time and within budget is not an easy task.    
Typically certain activities cannot start before the other to 
finish. 

   And if a project there are hundreds of such dependent 
planning problems are too complex, and managers need special 
methods of analysis. 

   Some of the questions that I tried to answer here are: 

1. What is the deadline for completion on the project? 

2. What are the start and end times of each activity? 

3. Which activities are critical in that they must and 
exactly as planned so as not to be exceeded deadline 
for completion of the project? 

4. How long can noncritical activities be delayed so as 
not be exceeded deadline for implementation of the 
project? 

5. How can resources be allocated so that the project 
activity to be performed quickly and with minimal 
costs? 

The methods PERT and CPM, acronyms for Program 
Evaluation Technique and Critical Path Method, Gant charts 
are methods of analysis used for project management. 
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Regardless of the method, the first step is to define the project 
planning activities and establish precedence relations between 
them ok. This is the most important project and normally at this 
stage would have involved more people so that should not be 
forgotten any important activity. 

   ABC currently has offices in Bucharest and only wants new 
offices in Brasov. In this purpose some staff will move to 
Bucharest and Brasov will hire new staff. While economists 
have to deal with the financial side of the business, architects 
must deal with the interior design. Some parts of the project 
can not start until others are completed. For example, it can be 
arranged offices if they were not design, or many employ 
personnel necessary until it sets. 

   The following table shows the activities that make up the 
project: 

TABLE VI. ACTIVITIES OF THE PROJECT 

Activity Description Previous 
activities 

Execution 
time(weeks) 

A Selecting 
offices 

- 3 

B Establishing 
the plan of 
organization 
and financial 

- 5 

C Determination 
of necessary 
staff 

B 3 

D Interior 
design 

A,C 4 

E Fitting offices D 8 

F Selection of 
personnel 
moves 

C 2 

G 

 

Hiring new 
staff 

F 4 

H 

 

The actual 
move 

F 2 

I 

 

 

Establishing 
relationships 
with new 
partners in 
Brasov 

B 5 

J Staff training H,E,G 3 

 

   Each activity is placed in a separate row and column last 
previous activities call activities to be performed before 
participation analyzed. For example, activity C cannot start 
until finish work in column B. Project duration is past the 
estimated time for implementation activities.  

GANT GRAPHICS 

One of the most popular methods used for project planning 
is to use GANT charts. Each activity is carried on the vertical 
axis. Horizontal is the time. The graph indicates the earliest 

starting time of each activity. For example, activity C cannot 
begin before C begins. As an activity is performed, the bar 
association is shaded. 

Thus, at any point of time is clearly what activities were 
carried out in time or not. The graph in the following figure 
below shows that in week 13 activities D, E and H are behind 
schedule and work ahead of G is the plan. 

Since there are complete in week 13 they are behind 
schedule. 

From GANT charts cannot determine immediate 
predecessors   of an activity.  

In the Figure 7 may seem like F and I are previous business 
activities G, since G may start in week 10, and F and I can 
finish it. 

But from Table VI we know that only F “immediate 
predecessor” of G. A delay of I activity would not affect that 
start time of activity G. 

Such information is important for the manager to determine 
what activities could be delayed without changing the deadline 
for the project. Gant charts may be used for such analysis, in 
this case the recommended method of representing the project 
in a graph. 

 

 

Figure 8.Gant Graphic 

REPRESENTATION THROUGH GRAPHS PROJECTS 

Each activity is representing in the graph by an arc. 
Beginning and end of each activity are indicated by a circle 
called node. Each node is assigned a number. The assignment 
of numbers is arbitrary. 

As the graph nodes can build numbers, but must be kept 
properly precedence relationships between activities. Each 
activity should begin in the node preceding activity ends. For 
example, in Figure 9, activity C starts in node 3 because 
previous work B and there. 
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Figure 9. Graph for activities from A to C 

 

Figure 10. Partial Graph 

The complications end when trying to add D activity graph. 
Both A and C are precedents for D activities, and how I want to 
graph D activity must occur only once to combine nodes 2 and 
4 in figure 9 into one. This is shown in Figure 10. Node 2 (were 
renumbered nodes) is the event in which A and C activities 
were completed. Activity E, whose only previous activity D 
can be added without difficulties. 

   When trying to add new problems arising from business F. 
As F has previous work on C, should work to start in node F. 
But this would work to start in node F. But this would mean 
that the activity is engaged in previous F and A, which is 
incorrect. This dilemma can be solved by introducing fictions 
activities, represented by the dotted line in Figure 11. 

 

The Figure 11. Introducing a fictitious activity 

This activity does not require any time or resources. Thus 
figure four shows that the activity can begin after D and C have 
been completed. Similarly, F can start after activity C to finish. 

I introduce a generalized way fictional work in the 
following way: suppose we want to add an activity A in node 
start n, but not all activities ending in node N are the activities 
and previous activities. To do this, create a new node M, a 
fictional work from node M to node N. All activities ending in 
N are predecessors of activity A will end in node M. It now 
work can begin in node M. 

 

The Figure 12.Network Graph 

 

Figure 12 show the graph associated Table 1. 

Each activity is identified by a start and one end node. The 
graph in Figure 12 may be confusion as G and H is the same 
activity. To avoid confusion insert a new fictional activity 
(Figure 13). 

 

 

 

The Figure 13. Introducing the second fictitious activities 

Thus the final graph looks like in the Figure 14. From table 
VI it can be calculated (gathering times of realization of 
activities) that the total realization of the project is thirty nine 
weeks. 
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The Figure 14. The final graph 

This term may be less because some activities can take 
place simultaneously (e.g. activities A and B). 

To find the minimum implementation of the project must 
calculate the critic road. A road trip in a graph is a sequence of 
activities and the initial node (1) to the end node (9). For 

example B I  sequence requires 10 weeks to be 

accomplished, the sequence B C D E J      23 weeks. 

In a graph can be identified more roads from the initial to the 
final node with different durations. There exists the following 
situation: how we determine the longest path from the initial to 
the final node. This path, called critical path can be project 
development time, because no other way is longer. If activities 
on the critical path are delayed, the entire project will be 
delayed. For this reason activities on the critical path are called 
critical activities. The critical activities must be carried out “on 
time” node with different durations. 

This path, called critical path will cause project 
development time, because no other way is longer. 

If activities on the critical path are delayed, the entire 
project will be delayed. For this reason activities on the critical 
path are called critical activities. 

The problem is solved in the following way: 

1.It is calculated for each activity at the earliest starting 
time and earliest completion time: 

I denote by: 

DI =earliest start time for activity; 

DT  =-early, the deadline for completion of activities; 

t  =the expected duration of activity; 

For an activity, the relationship between these quantities is 

DT DI t   (27) 

DI  = term for an activity that departs from a node is the 
highest DT of activities ending in that node. 

For each activity in the network are calculated  DT  and DI . 
The result is shown in the Figure 15. So, at the earliest project 
completion time is twenty three weeks. 

The Figure 15. Terms DI   and DT  

1.It calculates the last start and finish time of an activity. To 
identify critical activities and timeframes that non-critical 
activities can be delayed without affecting the project 
completion deadline, the graph back through the final node to 
initially node. 

The idea is that once we know the project implementation 
period (23 weeks), starting from this value we can calculate the 
latest time at which an activity can finish without delaying the 
entire project. Evaluation begins at the end node to initially 
node.  

We denote by: 

TI  =at the latest starting time of an activity; 

TT  =term no later than the end of an activity; 

The relationship between these quantities is: 

TI TT t  (29) 

TT  =term for an activity that ends in a node is the lowest 

TI  ‟s activities leaving from that node. The results are shown 
in Figure 16. 

 

The Figure 16. Calculations of  TI  and TT  

4. The Determination reserve time associated with each 
activity. Reserve time is the time that an activity can be delayed 
without affecting the project deadline. Reserve time (RT) is 
calculated using the formula:  

RT TI DI TT DT    (30) 

For example, activity G, reserve time is: 

16 10 6

20 14 6

G G G

G G G

RT TI DI

RT TT DT

    

    
 (31) 
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This means that G can delay work six weeks after the 
earliest starting time without delaying the project activity. 

The work C: 

5 5 0C C CRT TI DI      (32) 

So C activity is not the subject to time and must start in 
week 5. As the activity can be delayed without affecting the 
entire project, means that this activity is critical. 

Activities the reserve for 0 are critical activities.  

VI. TROUBLESHOOTING EXCEL 

Troubleshooting Excel Project Management is performed 
using a graph-based approach spreadsheet containing the model 
is shown in the Figure 16. Data and the resulting formulas are 
introduced graphical development project attached. 

For example, since the later –term termination activity F is 
the smallest value of the late start time of activities G, F and K, 
the formula in cell G7 will be=MIN(F8,F9,F12). Since the 
earliest start time for activity D is the highest value of the early 
termination terms of activities A and C, the formula in D5 is 
MAX(E2,E4). 

The last column is the word YES critical activity for 
activities that deviation is zero. 

 

 

Figure 16. Worksheet in Excel  

 

GRAPHIC REPRESENTATION OF GANT CHARTS IN 
EXCEL 

In Gant chart activities are displayed on the vertical axis 
and the horizontal axis is the time. The graph indicates the 
earliest starting time of each activity and duration of activity. 

GANT CHARTS 

1. Select data to be represented graphically: activities 
(A1:A11), duration activities (C1:C11) and the earliest starting 
time of activities (D1:D11). 

2.  It creates a chart type Staked Bar; 

3.  Select the DI series. Press the right button of your mouse 
and select the FORMAT command SERIES. Select the 
SERIES button is set to display Order and DI series order 
duration. Select the Patterns button, and SECTION AREA 
BORDER and NONE is selected. So starting bars attached 
terms of activities will be transparent and bars representing 
activities will occur during extension. 

Time series is selected, press the right button of your mouse 
and SELECT the Format COMMAND SERIES. Select the 
Scale button, options Categories in reverse order and value(Y)  
axis crosses at maximum category. Such activities will be 
displayed starting at the top of the Y axis.  

THE CRITICAL PATH ANALYSIS /COST 

To reduce development time of a project, the analyst can try 
reducing the time in which is carried out certain activities on 
the critical path by allocating additional resources. 

For example, a task that usually takes two weeks if working 
eight hours in a day it can be completed faster if they work 
overtime and increases the number of workers. This, of course, 
is achieved at the cost of increased costs.  

THE CRITICAL PATH ANALYSIS COST 

To reduce development time of a project, the analyst can try 
reducing the time in which is carried out certain activities on 
the critical path by allocating additional resources. 

For example, a task that usually takes two weeks if working 
eight hours in a day, it can be completed faster if they work 
overtime and it increases the number of workers. This, of 
course, is achieved at the cost of increased costs. The question 
is:” What activities should be expedited so that the final 
shortening the project implementation should be done with 
minimal cost?” 

This model assumes that the cost is a linear function of 
time, decreasing, because and any effort to speed is 
accompanied by increased spending. For each activity I know 
the following information: 

1. The normal-achieving the maximum activity; 

2. Normal cost, the cost necessary to achieve during 
normal working activity; 

Minimum-time is the minimum that can be work. 

Minimum-cost is the cost necessary to achieve the work in 
the minimum time; 

To present method I will use the following example: 

A project associated with the graph shown in the Figure 13 
consists of five activities. For each activity during normal 
known, the minimum average cost and the maximum cost. In 
the last column of the table was calculated for each activity cost 
per hour to speed equal to (maximum cost-normal 
cost)/(normal time, minimum time). 
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Figure 17. Representation of activities, normal time, normal 
cost, minimum time, maximum cost, duration speeding, 

cost/time  to speed 

Using normal duration for each activity, the earliest time for 
completion of the project is 194 hours (on the critical path C-D-
E). 

 

Figure 18. The graph associated to the problem 

To reduce the project completion time of 193 hours activity 
on the critical past must urgently hour. How to speed up cost 
per hour for activity D is less than the costs to speed up the 
time for activities C and E(8<10 and 8<16), it will speed D 
activity one hour. Thus, the project will end in 193 hours, C-D-
E critical path and the total cost will be 7208+8=7216. 

If the deadline must be further reduced to 191 hours, the 
problem is complicated. The situations illustrated in Figure 4. 
Now there are two critical path A-B-E and C-D-E, both of 192 
hours. 

Graphical completion time must be further reduced to 191 
hours, the problem is complicated. The situation is illustrated in 
Figure 4. Now there are two critical paths B-E and C-D-E, both 
192 hours. 

Graphical completion time must be reduced further to 191 
hours, the problem is complicated. The situation is illustrated in 
Figure 18. Now there are two critical paths B-E and C-D-E, 
both 192 hours. Urging one of the activities A,B,C,D with an 
hour will reduce road an hour, but still remains the critical path 
of 192 hours. A critical path of 191 hours can be obtained if 
urgency to activities on both roads, or if you just work urgency 
to E. So, there are many alternatives, and of these have found 
the solution that has minimum cost. For solving graphs in this 
way would be very cumbersome. The problem can be solved 
using linear programming. 

Figure 17 contains the model attached problem. 

In the first part of the spreadsheet is introduced during 
normal, normal cost, minimum time and maximum cost of 
achieving each activity. Based on these data, we calculate the 
maximum that length of column expedite the maximum that 
can be expedited each activity (the difference between the 
normal and the minimum), are in the next column expedite cost 
per hour maximum difference between the cost and time cost 
related. 

The second table of the spreadsheet contains the decision 
variables of the problems, which can be expedited times each 
activity in B9:B13. Initially all values will be 0.  The column 
length is calculated during work activity where it will be urgent 
speeding duration column value (difference between the normal 
and expedite time). 

Activation Duration Column is calculated during activity 
where it will be urgent speeding Duration Column Value 
(Difference between the normal and expedite time). The next 
columns are calculated the early and late periods of the start 
and end of each activity, following the sequence of activities 
(as in the example above). There for each is calculated 
deviations and enter formulas to determine the critical 
activities. 

The objective function (cell C15) is to minimize the total 
cost to speed, calculated as the sum of durations competitive 
products that are cost expedite urgency to each activity and 
activity per unit time-min (C15). The Problem constraints are: 

1.Duration within which the project which the project 
(contained in cell D14). For example, if the project should be 
completed in 184 hours, the restriction would be D14=184). 

2.The duration of each activity can be expedited not exceed 
the maximum length of urgency, and these durations are 
positive numbers so: Solve the problem using SOLVERS‟s and 
the results show that for the project to finish with minimal costs 
in 184 hours, have accelerated 2-D work hours and is 8 hours. 
Expedite additional cost in this case would be $ 144. 

VII. TROUBLESHOOTING DECISIONAL ANALYSIS 

The main elements of decision making are: 

1. The agent decision-making; 

2. The type of decision problem. If the problem parameters 
analyzed are known to say that we are dealing with decisions 
under conditions of certainty. In this case of events whose 
probabilities are known, it is said that decision-making takes 
place under conditions of risk. If the probability of occurrence 
of events are random (are not known), then the decision is 
adopted in conditions of uncertainty. 

3. Possible alternatives of action, which makers have at 
their disposal. 

4. Possible strategies of action managers. These strategies 
consist of various rules that allow the choice of variants of 
existing ones. 

5. The objectives of the decision (goal pursued managers). 
These objectives are materialized either restricted or the 
function end. 

Events that may occur, but the agent decision cannot 
control are referred to as states of nature. 

The decisional analysis models are shown in the following 
example: 
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The company PDC bought the land logs to build a villa 
complex. Their construction prices range from 300000 $ and 
1200000 $, depending on the number of rooms. 

The key factor is selecting one of the three alternatives is 
the correct assessment of the company‟s management of the 
future demand. Although the market may be influenced by 
advertising rates that are relatively high demand depend on the 
variety of factors over which management has no control.  

The company management believes that there are two 
possibilities: 

-acceptance of the project by the market, so high demand; 

-low demand; 

So, in the example analyzed there are two states of the 
nature. 

1S  =high demand; 

2S  =reduced demand; 

-also three alternatives: 

1d  =small sized project; 

2d  =medium sized project; 

3d  =large sized project; 

Using the best available information, the agent must 
evaluate each decision and state of nature gain to be obtained. 
Depending on the analyzed problem, this gain can be a profit, 
cost, time, distance, or any other measure that reflects outflows 
studied problem. 

In the table VI are presented the profits assessed for the 
problem analysis (in terms of millions of dollars): 

TABLE VI. PROFIT OBTAINED FOR EACH 

ALTERNATIVE AND STATE OF THE NATURE  

ALTERNATIVE STATES OF NATURE 

HIGH DEMAND( 1S ) 

REDUCED 
DEMAND 

( 2S  ) 

SMALL SIZED 
PROJECT 

8 7 

MEDIUM 
SIZED 

PROJECT 

14 5 

LARGE SIZED 
PROJECT 

20 -9 

- 31 20V    shows that if anticipates a profit of 20 million $ if 

the project of large size is selected and the demand will be 

high, 32 9V    shows that if you select the project of large 

size and the demand is low, we obtain a loss of 9 million od 
dollars. 

DECISION UNDER CONDITIONS OF UNCERTAINITY 

Decision problems containing uncertainty is not known 
when the likelihood of states of nature. These problems can be 
addressed in several ways, and accordingly there are several 

decision criteria. Because it by applying various criteria can get 
different advice is good decision agent to understand very well 
the existing criteria and to select the one that fits best, adverse 
to the best gain. 

REGRET CRITERION (CRITERION MINI-MAX) 

Alternative is chosen taking into account the difference 
between the best result that would have obtained a certain state 
and the value of other result. This difference is called regret: 

*| |ij J ijR V V  (33) 

Where: 

ijR  =the regret associated alternative id  and the state of 

nature jS  ; 

jV  =the corresponding gain the best decision for the state 

of nature jS  . For maximization problems 
*

jV  is the largest 

state of nature jS  , for problems of minimization 
*

jV  is the 

smallest value. 

ijV  =the gain corresponding to id  alternative and to state 

of nature jS  . 

The next step is to determine the maximum regret for each 
alternative. Ultimately will be selected alternative with the 
lowest ”regret” maxim. 

 

ANALYSIS PROBLEM SOLVING DECISION UNDER 
UNCERTAINITY IN EXCEL 

 

OPTIMIST CRITERION 

Figure 19 shows the spreadsheet to solve the problem with 
the CRITERIA OPTIMISTIC. 

The domain A4:C8 contains data problems. In the domain 
D6:D8 it calculates “maximum gain for each alternative” in cell 
D10 it calculates the greatest of “maximum gains of each 
alternative”. In the field E6:E8 it displayed the recommended 
alternative name. The formulas used are represented in the 
following table: 

TABLE VII. FORMUAS FOR OPTIMIST CRITERIUM 

Cell Formula It copies itself 

D6 ^MAX(B6:C6) D7:D8 

D10 ^MAX(D6:D8) - 

E6 ^IF(D6^$D$10,A6,” “) E7:E8 

  



 International Journal of Computer and Information Technology (ISSN: 2279 – 0764)  

Volume 02– Issue 05, September 2013 

 

www.ijcit.com    1040 

 

 

Figure 19. Optimist Criterium 

PESSIMISTIC CRITERIUM 

Figure 20 shows the spreadsheet to solve the problem 
with the CRITERIA PESSIMISTIC. The only difference 
between spreadsheets in Figures 19 and 20 is that the 
CRITERIA PESSIMISTIC determines winners minimum for 
each alternative. Thus, the cell D6 contains the formula 
^MIN(B6:C6), which is copied in cells D7 and D8.  

 

Figure 20. Pessimistic Criterium 

 

REGRETS CRITERIUM 

In Figure 21 is presented to solve spreadsheet with regret 
criterion. The domain A4:C8 contains the data of the problem. 

This problem involves determine the regrets associated with 
each alternative and each state of nature. The formulas used 
are: 

The Cell B14-calculates the “regret for the best value high 
demand state of nature” best value which demand state of 
nature. Wording is ^MAX($B$6:$B$8)-B6. It copies B14 into 
B15 and B16. 

The Cell C14-calculates the “regret” over the best value to 
the state of the nature ^MAX($C$6:$C$8)-C6. It copies C14 
into C15 and C16. 

The Cell D18 calculates the minimum of “maximum 
regret”. The formula used is:^MIN(D14:D16). 

The Cell E14-in the area E14:E16 it displays recommended 
alternative name. In E14 cell it enters the formula: 
^IF(D14^$D$18,A14,” “). E14 it copies into E15:E16. 

 

 

Figure 21. Criterium Regrets 

 

VII. DECISION UNDER RISK 

In many decision problems can estimate the probability 
arising state of nature. The main feature of decisions under risk 
is that the agent must choose a decision based alternative 
probability of state of nature. 

We denote by: 

N  -the number of states of nature; 

( )jP S -the probability of jS  conditions; 

At time can appear only a state of nature, so a probability 
must satisfy the conditions: 

1

1

( ) 0,

( ) ( ) ( ) 1

j

N

j N

j

P S for all states of nature

P S P S P S




    
 (34) 

The expected value VA  of an alternative id  is defined as 

follows: 

 

1

( ) ( )
N

i j ij

j

VA d P S V


  (35) 

 

In other words, “expected value” of an alternative is the 
weighted sum of “earnings” alternative analysis.  Share of a 
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win of state nature is the probability associated to the nature 

state j  . 

For the example analysis, if the probability of state of a 

nature are 0.8 for 1 20.2S i S  , we have: 

( 1) ^ 0.8*8 0.2*7 ^ 7.8

( 2) ^ 0.8*14 0.2*5 ^12.2

( 3) ^ 0.8*20 0.2*( 9) ^14.2

VA d

VA d

VA d





 

 (36) 

Will eventually be selected “expected value” the best 
(highest value for MAXIMIZING CRITERIA, lowest criteria 
for OPTIMIZATION).In the example analyzed the profit 

maximization try so is the best alternative is (with ^14.2VA  

). 

SOLVE THE PROBLEM USING EXCEL 

In the figure 4 it presents the spreadsheet used to make 
decisions under risk.  

 

Figure 22. Taking decisions in conditions under risk 

Areas A4:C9 contains data problems. The probability of the 
two states of nature is included in cells B9 and C9.  

In the field D6:D8 it calculates “expected value” for each 
alternative and in the field E6:E8 it posted the name of 
recommended alternative.  

The formulas used are: 

-Cell D6-calculates the expected value of alternative D1. 
The wording is: ^SUMPRODUCT($B$9:$C$9, B6:C6). It 
copies D6 into D7  and D8. 

-Cell E6->it determines the alternative recommended . The 
wording is: ^IF(D6^$D$11,A6,” “).It copies E6 in E7:E8. 

For a minimization problem only modification would be 
changed spreadsheet formula in cell D11 in ^ MIN(D6:D8). 

VIII. DECISIONAL ANALYSIS PROBLEMS USING 

SOLVER 

A company has three factories in cities A, B and C. The 
products manufactured in these factories are distributed in 
localities S and P. The company is considering whether a new 
warehouse location in town R. 

The analyses have established the following costs: 

TABLE VIII. REPRESENTATION OF FACTORIES 
AND COST OF TRANSPORTATION IN DEPOSITS 

COST OF TRANSPORTATION IN 
DEPOSITS FROM 

FACTORIES S P R 

A 10 14 8 

B 12 10 12 

C 8 12 10 

 

Production capacity at factories in cities A, B and C are 20, 

30 and 40 units a week. R  is estimated that the deposit will 
graduate 20 units per week, while the S and P, 40 and 30 units 
a week. To determine the distribution of products in 
warehouses so shipping costs to a minimum. The model will 
have 9 decision variables: 

1x   the number of products transported from factory A to 

the warehouse R; 

2x   the number of products transported from the factory 

A to deposit P; 

3x   the number of products transported from the factory 

A to the warehouse R; 

4x   the number of products transported from the factory 

B to the warehouse S; 

5x   the number of products shipped from the factory B to 

the warehouse P; 

6x   the number of products transported from the factory 

B to the warehouse R; 

7x   the number of products transported from the factory 

C to the warehouse S; 

8x   the number of products transported from the factory 

C to the warehouse P; 

9x   the number of products transported from the factory 

C to the warehouse R; 

The restrictions of the model are: 

1. 1 2 3 20x x x   (37) 

 The production from the factory A does not exceed the 
production capacity: 

2. 4 5 6 30x x x   (38) 

 The production from B factory does not exceed the 
production capacity: 

3. 7 8 9 40x x x    (39) 

  The production from C factory does not exceed the 
production capacity: 

4. 1 4 7 20x x x   (40) 
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The number of products carried in the store A has to be 
high than the storage request) 

5. 2 5 8 40x x x   (41) 

The number of products carried in the store B has to be 
higher than the storage request) 

6. 5 6 9 30x x x   (42) 

The number of products carried in the store C has to be 
higher than the storage request) 

The objective function of the model is to minimize 
transportation costs. Transportation costs are equal to: 

1 2 3 4 5 6

7 8 9

10* 14* 8* 12* 10* 12*

8* 12* 10*

x x x x x x

x x x

     

 

(43) 

To solve this problem will be configured in the following 
manner spreadsheet with initial data input: 

 

Figure 23. Initial Data Solver 

Menu cells C3:E5 will contain variables model. At first 
these cells will be filled with random data, assume that all 
variables are equal to 1. After solving the problem in these cells 
will get the result. In cells B3, B4, B5 I shall calculate the total 
production in each factory. 

In cell B3 I shall enter the formula=SUM(C3:E3).It is 
copied the formula in B4 and B5 . 

In cell C6, D6, E6 it is calculated the output stored in each 
warehouse. In cell C6 I shall enter the formula=SUM(C3:C5). 
This formula is copied in D6 and E6. 

The cells B10, B11, B12 contain production cost factories 
A, B and C. 

The cells C13, D13 and E13 I shall introduce transportation 
costs per unit of product from each factory to store. 

In cells C15, D15, E15 I calculate shipping costs in each 
store. In cell C15 I enter the formula 

1215 3 10 4 11 5* * *C C C C C C C   (44) 

(number of products transported from factory A to store 
S*transport costs + number of products transported from 
factory B to store S*transport costs + number of products 
transported from factory C to store S*transport costs). This 
formula it copies in cells D15 and E15. In cells B15 shall 
calculate transportation costs. In this cell I shall enter the 

formula ( 15: 15)SUM C E  . 

Restrictions for the problems designed for the spreadsheet 
will be: 

3 10B B (45) 

-the production from factory A doesn‟t exceed the capacity; 

4 11B B (46) 

-the production from B factory doesn‟t exceed the capacity; 

5 12B B (47) 

-the production from C factory doesn‟t exceed the capacity; 

6 13C C (48) 

-will not be breaking the stock at the warehouse S; 

6 13D D (49) 

- will not breaking the stock at the warehouse P; 

6 13E E (50) 

-will not breaking the stock at the warehouse R; 

3 5: 0C E  (51) 

-all variables must be negative numbers; 

After the spreadsheet was configured, from the Data Menu 
it applies SOLVER command. 

The objective of the problem is to minimize the total 

transport costs. This value is calculated in cell 15B  , so in SET 

TARGET CELL is inserted 15B . 

The function must be minimized so that I will choose MIN 
function. The cells containing input variables are in the range 

3 5:C E  so in BY CHANGING CELLS introduces 3 5:C E . 

In the box Subject to the CONSTRAINTS it shall introduce 
the restrictions of the problems: 

1. Select the ADD button. 

2. In the Cell Reference Box introduces 3B  . 

3. From operators list selects   . 

Similarly the other restrictions are inserted. 
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Figure 24. Solver Parameters 

Finally box Solver will be completed as shown in Figure 
24. 

Select button OPTIONS. In the dialog box SOLVER 
OPTIONS is marked ASSUME LINEAR MODEL and 
ASSUME NON NEGATIVE. Select OK button SOLVER. 

In the box SOLVER RESULTS select the option KEEP 
SOLVER SOLUTIONS and the three reports. 

Solver solves the problem. 

The obtained result is: it will transport 20 products from 
factory A to deposit R, 30 products from factory B to deposit P, 
20 products from factory C to deposit S, 10 products from 
factory C to deposit P, 10 products from factory C to deposit R.  

IX. MICROSOFT EXCEL-SPREADSHEET FORMAT, 

SIZING CELLS, FONT, SIZE, STYLE, FORMATTING 

NUMBERS, ALIGNMENT, BORDERS, COLORS AND 

CELLS, REFERENCE CELLS IN A SPREADSHEET, 

ABSOLUTE AN RELATIVE REFERENCES, REFERENCE 

3D, CELL VALIDATION, CALCULATIONS USING 

FORMULAS 

 
Microsoft Excel is currently the most common spreadsheet 

program. Excel can hold out a lot of information (text, 
numbers) and can produce a wealth of information about these 
numbers and offers all the facilities for presenting them in a 
professional format. Using Excel, the user benefits from several 
advantages including: 

-work environment more efficiently by customizing this 
program; 

-automating various tasks using macros, templates and 
formulas; 

Working file (workbook) and spreadsheet (worksheet) 

In Microsoft Excel a file can contain multiple spreadsheets, 
which allows organizing various types of information in a 
single file. Spreadsheets are used for printing and analysis. 
Data can be entered on multiple spreadsheets simultaneously, 
and can perform calculations with data form multiple 
spreadsheets. Charts created using data from a spreadsheet can 

be placed on the same worksheet or can be placed in different 
worksheet. 

To move a sheet into another it selects a specific sheet here. 
Name spreadsheet at one point (bold ). 

A spreadsheet consists of several distinct cells, where they 
can register different values.  

SPREADSHEET FORMAT 

Formatting a spreadsheet cells involves sizing, setting and 
style font, number format, alignment of the use of frames and 
colors, elements shown in the following figure: 

 

Figure 25. Spreadsheet Format 

SIZING CELLS 

Columns and rows can be resized if they move the line 
between two names of rows and columns. To match long data 
in the cell the columns and rows can be resized if it is double 
click on the head row or column. Because all data in the cell 
appear, not resize columns, using the alignment format MENU 
to decrease the text or CELLS to enter multiple lines in a cell. 

FONT, SYZE, STYLE 

The font, size, style or color of selected data cells can be 
modified using the options in the task bar formatting. 

FORMATTING NUMBERS 

You can use different formats for numbers by selecting 
buttons on the task bar formatting. Other numbers can be used 
if you select the MENU button NUMBER FORMAT/CELLS. 

ALIGNMENT 

To align data using taskbar buttons formatting. To place 
data in other directions ALIGNMENT menu button using 
FORMAT CELLS. 

BORDERS, COLORS and CELLS 

Application of cells frame for SELECT menu options 
borders, taskbar formatting. All of this bar can be select FILL 
COLOR button to apply different colors of cells. 

REFERENCE CELLS IN A SPREADSHEET 

References it identifies a cell or a range of cells in a file 
thing. References allow use of data from different worksheets 
in the same file work in various work files or data from other 
programs. Cell References in various work files are called 
external references. Reference data from other programs are 
called remote references. By default, Microsoft Excel uses  the 
A1 reference type (marking columns) and lines with numbers 
(1 to 65536). Refer to a cell, designating specific column letter 
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followed by the number that specifies line. (For example cell 
D50 refers to the intersection of column D with line 50). 

To reference a number of cells required cell reference in 
upper left corner and one in the lower right corner, separated by 
“.”  

TABLE IX. EXAMPLE OF REFERENCES IN EXCEL 

Refers to Is used 

Cell from column A and line 
10 

A10 

Range of cells in column A, 
lines 10 and 20 

A10:A20 

Range of cells in column A, 
lines 10 and 20 

B15:E15 

All cells of line 5 5:5 

All cells lines 5:10 5:10 

All cells in column H H:H 

All cells in column H:J H:J 

 

It can also be used a reference model in which both lines 
and columns in a worksheet to be numbered. Style “R1C1” is 
useful when working with macros and highlight relative cell 
reference. Cell position is indicated as R followed by the line 
number and the column number C followed.  

Remarks: 

In more cells in a spreadsheet can be grouped into a single 
cell by selecting MERGE CELLS-DIALOG BOX FORMAT-
CELLS-ALIGNMENT. In order to ungroup, go OPTION to 
CANCEL your selected ABOVE. 

ABSOLUTE AND RELATIVE REFERENCE 

When create a formula, cell reference or range of cells 
based on their relative position to the cell containing the 
formula. In the example in the following table cell B6 contains 
the formula=A5. Microsoft Excel will find the search value 
once cell above and once cell to the left of B6. This type of 
reference is known as relative reference. 

 

Figure 26. Relative Reference 

When you copy a formula that uses relative references, 
references are updated and the new formula will refer to other 
cells depending on the position of the formula. In the above 
example, the formula in the cell B6 has been copied to cell B7. 
Formula in B7=A6 turned in, that relates cell one position and 
one position left to the B7.  

 

Figure 27. Formulas 

For references remain unchanged by copying formulas. 
Absolute references are used by inserting the character “$” in 
front references that we will not change. If the mean absolute 
cell A5, above formulas becomes:=‟$A$5”. 

 

 

 

LABELS AND NAMES IN FORMULAS 

Often we have labels worksheets at the end of each column 
and the left of each live to describe the data in the spreadsheet. 
These tags can be used in formulas to reference the data from 
these columns or rows. Also, you can create descriptive names, 
different labels to represent cells, range of cells, formula or 
constant. 

When writing a formula that refers to data in a worksheet 
can use the labels to represent cells, range of cells, formula or 
constant.  

When writing a formula that refers to data in a worksheet 
can use the labels of columns and lines. For example, if a table 
contains quantities sold in a column  labeled “Sales” and a line 
labeled “Computer”, we can determine how many computers 
were sold “with formula”=”Computer Sales”. The space 
between the labels is intersection operator, which specifies that 
the formula will return the value of the cell at the intersection 
line labeled “Computer” in a column labeled “Sales”.  

If the data are not labeled or if you want to use the 
information in a spreadsheet and other spreadsheets in the same 
file work, you can use the name that describes the cell or range 
of cells. 
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These names are set as follows:  first select the cells you 
want and enter the desired name in the Name Box on the left 
side of the bar with formulas. 

For example, the formula”=SUM(First Quarter Sales”)is 
easier understand than”=SUM(Sales!C20:C30)”, hence the 
name “First Quarter Sales” is given a range of cells(C20:C30). 

Assigned names will be available in either a spreadsheet 
file. Note: By default, the name used absolute references. 

 

REFERENCE 3-D 

To analyze data from the same cell or range of cells from 
many spreadsheets of a file using 3-D references. A 3-D 
references implies reference cell or series of cells preceded by 
exclamation mark (!) followed by worksheet name. 

For example, the formula”=SUM(Sheet 2:Sheet 13!B5)” 
will gather values in cells B5 in all worksheets from the second 
to on the 13th. 

CELL VALIDATION 

In Microsoft Excel it is possible to restrict the values that 
can be entered into cells in a spreadsheet. This is done using 
Validation Option in Data Menu. 

Phases of restrictions: 

1. Select the cell. 

2. Choose Settings from the Menu Option Data-
>Validation; 

3. From allow dialog box, choose the desired data type 
and ENTER the lower and upper limits for values; 

4. To display the Error Message Explanatory or choose 
options Input Message and Error Alert; 

TYPES OF RESTRICTIONS 

Option dialog Box Data->Validation. Change depending on 
what was selected in the dialog box Allow and Data. In the 
following table it describes and explained the types of 
restrictions: 

TABLE X. TYPES OF RESTRICTIONS 

Type Describe and options 

Any Value No restriction. 

It is used to display a message 
without checking its validity. 

Custom Allows use of formulas or 
expressions to determine 
values. 

Date Specific the necessity of 
introduction a date 

List Allows to user to specify a list 
of valid values 

Time Input Data must be of type 
long 

Whole Numbers Data must be integers 

 

CALCULATIONS AND FORMULAS 

CALCULATIONS USING FORMULAS 

A formula is an equation with which to operate on data in a 
worksheet. Thus, you can make additions, multiplications, 
comparisons between values from different worksheets, also 
can combine different values. 

Formulas can work with cells in the same spreadsheet, 
different worksheet cells, but the same file work or different 
work cells files. 

Always Microsoft Excel formulas begin with the character 
“=” followed by various on the desired cell (+, -,*,/) . In the 
table below are some examples of using the various types of 
formulas. 

TABLE XI. TYPES OF FORMULAS 

Types of Formulas Result 

Simple Formulas  

=128+345 Add numbers 128 and 345 

=5^2 Picks 5 to the power 2 

Formulas that contains 
references or name 

 

=C2 Take the value from the cell 
C2 

=Sheet2!B2 Take the value from cell 
B2 from the spreadsheet 
Sheet2 

=Gross Returns-Tax 

 

Decrease a cell named Tax 
from a cell called Income Tax 

 

Formulas that contain 
functions 

 

=SUM(A:A) 

 

Adds the values in column A 

=AVERAGE(A1:B4) 

 

Calculates the average from 
the values in the field 

 

The article “Nonstandard operator precedence in Excel”  by 
Roger L. Berger tells that  “Microsoft „s Excel spreadsheet 
program implements an unusual operator precedence in 
formulas. This can cause errors in statistical calculations, if it is 
not properly followed. For example, some errors by Excel in 
nonlinear regression reported by McCullough and 
Wilson(2002.On the accuracy of statistical procedures in 
Microsoft Excel 2000 and Excel XP. Comput. Statist. Data 
Anal. 40, 713-721) were probably due to programming by the 
users that did not follow the unusual operator precedence rules. 
In this note the operator precedence in Excel is explained, the 
previous nonlinear regression results are corrected, and a 
simple example of maximum likelihood estimation is given”. 
[1]  
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X. USING FUNCTIONS 

Functions are predefined formulas that perform calculations 
on values, called arguments, in a certain order, called SINTAX. 
For example, the SUM function adds value or range of cells, 
and PMT function calculates rates of loans by interest rate, loan 
term and the amount borrowed.  

Arguments can be numbers, text, logical values (true or 
false), massive error values (#N/A) or cell references. They can 
be also constants, formulas, or other functions. The syntax of a 
function begins with the function name followed by the 
arguments list, which are between parentheses and separated by 
commas. 

Available functions are grouped into several categories, 
including: 

1. Functions or type date and time; 

2. Financial functions; 

3. Logic functions; 

4. Mathematical and trigonometric functions; 

5. Statistical functions; 

6. Database functions; 

7. External functions; 

8. Engineering functions; 

9. Information functions; 

10. User-defined functions; 

In conclusions of   “Nonstandard operator precedence in 
Excel” are presented the following ideas “Microsoft‟s Excel 
spreadsheet program implements an unusual order of operator 
precedence. Unary negation has a higher order of precedence 
than any other arithmetic operation. Care must be taken when 
using formulas in Excel to ensure their correct calculations, 
given this operator precedence. This can be easily achieved by 
the liberal use of parentheses to ensure that the correct order of 
evaluations is clearly spelled out. In some previously reported 
tests of Excel‟s Solver tool on nonlinear least squares 
regression problems, it appears that formulas may have been 
entered incorrectly given Excel‟s operator precedence. When 
the formulas defining the regression model are correctly 
entered, Excel‟s Solver gives reasonable estimates. 

However, Excel‟s performance is not improved by 
considering operator precedence in many other nonlinear least 
squares regression problems nor in other types of problems. So, 
despite some improvements reported in this paper, Excel still 
cannot be recommended as a general purpose statistical 
package. Excel‟s usage should still be limited to simple 
pedagogical examples.” [1] 

FUNCTIONS OF TYPE DATE AND TIME 

Functions of type and time (Date and Time) manipulates  
and operate calculation of numeric values representing dates 
and times; 

1. NOW()-returns a decimal number meaningfully 
representing the current date time; 

2. TODAY()-returns a number representing the current 
date; 

3. DATEVALUE(“string”)-calculates the number 
corresponding to the string-date calendar date 
format(string should be enclosed in double quotes); 

4. DATE(year, month, day)-calculated number 
,,corresponding to the string-date calendar date 
format(string should be enclosed in double quotes); 

5. YEAR(number, date)-returns the year corresponding to 
the date, a number between 0 (1900) and 199 (2099); 

6. MONTH(number, date)-extracts month from a total-
date in the form of values between 1 and 12; 

7. DAY(total-time)-generates  a corresponding number of 
day with values between 1 and 31; 

8. WEEKDAY(x)-returns the number of the day of the 
week corresponding argument x, which can be a 
number text date or a calendar date format; 

9. DA0YS360(start  date, end date)-calculates the number 
of days between two days considering year as having 
360 days; 

10. TIME(hour, minute, second)-calculates a total for the 
corresponding hour, minutes and seconds; 

11. TIMEVALUE(“string”)-returns the number 
corresponding to the string-time format specified in 
date/time(in quotation marks)  

12. HOUR(NUMBER-TIME)-extracts the hour from a 
number-time(0.000000  for hour 24:00:00 and 
9,999988426 for hour 23:55:39) as a number between 
0 and 23; 

13. MINUTES(total-time) minute extracts the minute from 
a number time, as an integer between 0 and 59; 

14. SECOND(number, time)-extracts the second from a 
number time as an integer between 0 and 59; 

FUNCTIONS OF TYPE DATE AND TIME 

 

 

Figure 28. Date and time functions 

FINANCIAL FUNCTIONS 
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Financial functions are used to conducting to making of 
calculation specific to business domain, such as determining 
the value of an investment or future of value of shares and 
bonds. 

Among the most common arguments of these functions 
may be specified: 

1. Future value (FV)-the value of an investment or a loan 
after making all payments; 

2. The number of periods(NPER)- the total number of 
installments or for an investment period; 

3. Sum payment (PMT)-the amount of money paid 
periodically for an investment or a loan; 

4. The present value (PV)-the value of an investment or a 
loan value earlier period; for example the present value 
of a loan is the amount of money that is borrowed; 

5. Rate(RATE)-the interest rate for a loan of an 
investment; 

6. Type(TYPE)-the interval in which payments are made 
within the payment period( beginning and end); 

LOGIC FUNCTIONS (AND, IF, OR) 

Logic functions are used to test the truth value of one or 
more conditions. For example, using the functions IF a certain 
value is returned IF it meets CONDITION and another for 
value false conditions: 

1. Function AND(argument1, argumnet2,…) returns true 
if all arguments are true; returns false if one or more 
arguments are false; 

The function can have up to 30 arguments, true or false. 

NOTES: Be expressed by-arguments logical values; 

-if references an argument contains text or is blank, then 
that argument will be ignored; 

-if there is expressed in series logical values, and function 
returns the #value! 

Examples: 

1. AND(TRUE, TRUE)-returns TRUE; 

2. AND(TRUE, FALSE)-returns FALSE; 

3. AND(2+2=4, 2+3=5)-returns TRUE; 

4. IF the cells B1:B3 contains the values TRUE, FALSE 
and  TRUE  AND(B1:B3) returns FALSE; 

5. If the cells B1:B3 contain the values TRUE, FALSE 
and TRUE  AND(B1:B3) returns FALSE; 

6. In B4 assuming there is a number and that number IF 
WANT display is between 1 and 100 ERROR 
MESSAGE OR OTHERWISE. 

7. IF B4 contains the number 104, then: 

a). IF(AND(A<B4, B4<100),104,”THE VALUE 
EXCEEDED”) returns the value exceeded; 

b).    IF contains 50, then IF(AND(1<B4, B4<100), B4, 
“VALUE EXCEEDED”) returns 50. 

2. Function IF(CONDITION, VALUE_IF_TRUE, 
VALUE_IF_FALSE)-returns a value IF specified 

condition is evaluated as TRUE, and another when 
judged as FALSE; 

-CONDITION is any value of expression can be 
evaluated logic if; 

-VALUE_IF_TRUE is the value that will be returned 
if the conditions met, if the condition is true and the value 
VALUE_IF_TRUE is omitted, it returns true. 
VALUE_IF_TRUE can be and a certain formula. 

-VALUE_IF_FALSE is returned in case of failure 
conditions. If the condition is false and 
VALUE_IF_FALSE is omitted, it returns FALSE. 
VALUE_IF_FALSE may also be another formula. 

NOTES: 

-can nest up to IF FUNCTION; 

-when evaluating VALUE_IF_TRUE and 
VALUE_IF_FALSE, IF returns the value returned by this 
argument; 

-IF ANY of the arguments are MASSIVE if function, 
each element of the massive evaluates to if function 
execution. If some arguments are functions, they will be 
executed individually; 

Example: 

Assume the following test: IF the value of cell A10 is 
100, the condition it is true and calculate the total for the 
series B5:B15. Otherwise, the condition is false and the 
cell that contains the function if nothing is written. 

IF(A10=100, SUM(B5:B15), “ “) 

3. Function OR(ARGUMENT1, ARGUMENT2, …) 
returns true if any of the arguments is true, return false 
if all arguments are false; The function can have up  to 
30 arguments. 

1. OR(TRUE)->returns TRUE; 

2. OR(1+1=1, 2+2=5) returns TRUE; 

3. IF A1:A3 contain the value TRUE, FALSE and 
TRUE, THEN OR(A1:A3) returns TRUE; 

 

Figure 29.Mathematical and trigonometric functions 

    The  mathematical and trigonometric functions (math & trig) 
to allow carrying out various calculations, from the simplest to 
the most complex, for applications that require solving 
mathematical tools and trigonometric current use. Category and 
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the mathematical functions are related to matrix computations. 
The main functions related to the calculation of matrix 
determinant calculation are related, matrix inverse and product 
of two and a transposed matrix. 

1.FUNCTION MDETERM (MATRIX), this function 
returns the determinant of a matrix. Matrix is numeric and must 
have the number of rows equal to the number of columns. It 
can be given as a range of cells, for example A1: C3 as an array 
constant, such as {1,2,1 | 4,2,1 | 1,1,2}, or as a given name 
each. 

If any cells in array are empty or contain text, MDETERM 
returns the # VALUE!; 

MDETERM also returns # VALUE! if the matrix has the 
same number of rows and columns. 

Remarks: 

1.The determinant is a number derived from the values 
array. For a matrix with three rows and three columns, A1: C3, 
the determinant is defined as: 

( 1: 3) 1*( 2* 3 3* 2)

2*( 3* 1 1* 3)

3*( 1* 2 2* 1)

MDETERM A C A B C B C

A B C B C

A B C B C

  

 



 (51) 

Determinants are generally used for solving systems of 
mathematical equations that include more variables. 

Examples: 

1. 

({1;3;8;5 |1;3;6;1 |

1;1;1;0 | 7;3;10;2}) 88

MDETERM


 

(52) 

 2. 

({1;3;8;5 |1;3;6;1}) # !MDETERM VALUE  

(53) 

-because the matrix hasn‟t the number of rows equal with 
the number of columns; 

2. FUNCTION MINVERSE (MATRIX) –returns for 
matrix the inverse matrix stored in a massive data. The matrix 
must be a matrix numbers with an equal number of rows and 
columns. 

-The matrix can be given as a cell range such as A1:C3 as 
an array constant, such as {1;2;3|4;5;6|7;8;9} or a name for 
each of these; 

-If any cells in array are empty or contain text, MINVERSE 
returns the #VALUE! 

-MINVERSE also returns the #VALUE!  If the matrix is 
not equal with to the number of rows of columns. 

 

OBSERVATIONS: 

 

1. Formulas that returns matrix must be introduced as 
matrix formulas; 

2. The reverse matrix as determinants are geo 1 and 
generally used for solving systems of mathematical equations 
with multiple variables. 

3. The inverse matrices, like determinants, are generally 
used for solving systems of mathematical equations with 
multiple variables. The product of a matrix and its inverse is 
the matrix square where unit-diagonal elements are equal to 1 
and cell other elements are 0. 

Like how the calculation is made for proper matrix with 
two rows and two columns, we assume that the range A1:B2 
contains the letters a, b, c, d, which represents any four 
numbers. The following table presents the calculation of the 
elements of the inverse matrix A1:B2. 

TABLE XII. MATRIX 

 Column A Column B 

Row 1 / ( * * )d a d b c   / ( * * )b b c a d   

Row 2 / ( * * )c b c a d   / ( * * )a a d b c   

 

MINVERSE is calculated with a precision of about 16 
decimal places, which can lead to a very small numerical error 
if the rounding is done. 

Some square matrices cannot be inverted and will return the 
#NUM! through MINVERSE function. 

Noninverting determinant of a matrix is 0. 

Examples: 

1. 

 

({4; 1| 2;0}) {0;0,5 | 1;2}MINVERSE equal 

(54) 

 

2. 

({1;2;1| 3;4; 1 | 0;2;0})

{0,25;0,25; 0,75 | 0;0;0,5;| 0,75; 0,25; 0,25}

MINVERSE equal

  
 

(55) 

 

Figure 30. Minverse 
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1. FUNCTION MMULT(ARRAY 1; ARRAY 2) 

- It returns matrix product of two arrays. The result is a 
matrix with number of rows with the same number of 
rows from matrix1 equals with the number of columns 
that has the matrix 2. 

- ARRAY 1; ARRAY 2-are matrices to be multiplied. 
The number of columns from MATRIX1 must be 
equal to the number of rows from MATRIX2 and both 
array must only contain numbers. 

- ARRAY1 and ARRAY2 can be given as areas of cells, 
constants, array or reference. 

- Remarks: The matrix resulted from multiplication of 
matrix B and C is: 

*ij ik ika b c  

(56) 

- where i  -represents the number of rows; 

- and j  -represents the  number of columns; 

- The formulas that return arrays must be entered as 
matrix formulas. 

({1;3 | 7;2} ; {2;0 | 0;2})

{2;6 |14;4}

MMULT

equals
 

(57) 

 

({3;0 | 2;0} ; {2;0 | 0;2})

{6;0 | 4;0}

MMULT

equals
 

(58) 

({1;3;0 | 7;2;0 |1;0;0};

{2;0 | 0;2})

# !

MMULT

EQUALS

VALUE
 

(59) 

- because the first matrix has 3 columns and the second 
matrix has only two lines. 

 

Figure 31. Mmult 

 

2. OTHER COMMON MATHEMATICAL 
FUNCTIONS 

FUNCTION SUM(LIST) –collects the values from a 
list specified as an argument. The list can contain 
certain continuous and discontinuous fields referenced 
by address or more fields. Select the set of cells to 
sum, including the area where they post the results of 
summation then is the sum. 

1. FUNCTION PRODUCT(LIST)-multiply the values 
contained in a list. To calculate the value of the 
products we sold te unit price multiplied by quantity. 

2. FUNCTION SUMPRODUCT(LIST)-multiplies 
corresponding values located in cells for a series of 
fields, and then add the results. With this feature we 
calculated total sales, for example  the sum of 
products quantities (C2:C7) and prices (D2:D7). 

3. FUNCTION SUMIF(FIELD ASSESSMENT; 
CRITERION; FIELD AMOUNTED)- collect cell 
contents according to given criterion. 

Example: Let‟s calculate the amount of commissions from 
sales of products sold over 100000000 RON values for 
products in the following table. We use the SUMIF(), for which 
the field is evaluated values of cells(D2:D6) criterion is text, 
namely” >10.000.000” and the amounted filed is. 

 

 

Figure 32.Sum and Sumif 

STATISTICAL FUNCTIONS 

Statistical functions (statistics) for making statistical 
calculations using sets of values: 

1. FUNCTION MAX(LIST)-returns the largest value 
from the list. The list can be composed of: numbers, 
numerical formulas, addresses or names of field. 

 

2. FUNCTION MIN(LIST)-returns the smallest value in 
the list.  

 
3. FUNCTION AVERAGE(LIST)-calculates the 

arithmetic mean of the list. 
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4. FUNCTION MEDIAN(LIST)-calculates the median of 

the list.  

 
5. FUNCTION GEOMEAN(LIST)-calculates the 

geometric mean of the list. 

In the article “On the accuracy of statistical procedures in 

Microsoft Excel 2007” by B.D. McCullough and David A. 

Heiser “Excel 2007, like its predecessors, fails a standard set 

of intermediate-level accuracy tests in three areas: statistical 

distributions, random number generation and estimation. 

Additional errors in specific Excel procedures are discussed. 

No statistical procedure is Excel should be used until 

Microsoft documents that the procedure is correct; it is not 

safe to assume that Microsoft Excel‟s statistical procedures 

give the correct answer. Persons who wish to conduct 

statistical analysis should use some other package”. [2] 
In the following table using the functions described in order 

to calculate statistical indicators for sales activity. Value on 
outlets selling: 

 

Figure 33. Statistical functions 

So I applied statistical functions presented in the following 
figure: 

 

Figure 34. Statistical functions with formulas 

Conclusions of  article “On the accuracy of statistical 
procedures in Microsoft Excel 2007” by B.D. McCullough and 
David A. Heiser “  are “ The statistical literature has regularly 
identified flaws in Excel‟s statistical procedures at list since 
Sawitzki(1994),  and Microsoft has repeatedly proved itself 
incapable of providing reliable statistical functionality. It is 
little wonder that introductory texts on statistics warn students 
not to use Excel when the results matter (e. g. Keller(2001) and 
Levine et. al. (2002)). There is nothing inherently difficult 
about programming a spreadsheet that precludes reliable 
statistical programming. The open-source spreadsheet package 
Gnumeric was originally such a good Excel clone that it even 
reproduced many Excel errors. When informed that these were 
errors, the handful of part-time programmers who maintain 
least so far as consumers of statistics are concerned, is that 
Microsoft seems to take the approach that specialized domain 
knowledge is not necessary to the production of statistical code, 
i.e. , that the entire field of statistical computing has no merit. 
As but one case to illustrate this point, in KB 829215, 
Microsoft discusses the enhancements made to the ATP 
ANOVA function in Excel 2003. The KB describes 
pseudocode for the computations in previous versions of Excel; 
this pseudocode embodies an algorithm that would be 
implemented by no one who has read an introductory text on 
statistical computing, e. g. Kennedy and Gentle(1980) or 
Thised (1988 ). Microsoft then remarks, Again, for model 2 and 
model 3, sums of squares are calculated and a quantity is 
subtracted from the sum of squares as in calculator formula. 
Unfortunately, basic statistics text frequently suggest 
approaches for ANOVA such as the one that is shown earlier in 
this article. 

The obvious implication is that Microsoft programmed its 
statistical functions by using statistics texts, rather than 
statistical computing texts. Of course, this approach to 
programming –eschewing specialized domain knowledge-
explains much of Microsoft‟s inability to program functions 
correctly. 

The improvements in Excel 2003 gave hope that Microsoft 
might finally be committed to providing reliable statistical 
functionality in Excel. That Microsoft once again decided to 
allow errors to remain unfixed, or fixed incorrectly, in the 
Excel 2007 release dashes those hopes. Regardless of the 
reasons for Microsoft‟s inability to program Excel correctly, 
Microsoft has had years to fix these errors, and has proven 
itself unable to do so. It is clear that when Microsoft claims to 
have “fixed “ a procedure that is known to be in error, 
Microsoft‟s claim cannot be safely believed. It is also clear that 
there are procedures in Excel that are in error, and Microsoft 
either does not know of the error or does not know of the error 
or does not choose to warn users that the procedure is in error. 
Since it is generally impossible for the average user to 
distinguish between the accurate and inaccurate Excel 
functions, the only safe course for Excel users is to rely on no 
statistical procedure in Excel unless Microsoft provides 
tangible evidence of its accuracy consisting of: 

1. test data with known input and output; 

2. description of the algorithm sufficient to permit a third 
party to use the test data to reproduce Excel‟s output; 
and; 

3. a bona fide reference for the algorithm; 

If Microsoft does not perform these actions for each 
statistical procedure in Excel, then there are only two safe 
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alternatives for the user who is concerned about the accuracy of 
his statistical results: the user can perform all these actions 
himself, or simply not use Excel.”[2] 

  In the article “On the accuracy of statistical distributions in 
Microsoft Excel 2003” by Leo Knusel “Some of previously 
indicated errors in Microsoft Excel 97 and Excel XP have been 
eliminated in Excel 2003. But some others have not been 
corrected in Excel 2003 and new ones have been found as is 
shown by numerical examples.”[3] 

To perform complex calculations requiring multiple IF 
formula or existing formulas are not enough, users can define 
their own functions VISUAL BASIC EDITOR USING proceed 
as follows: 

1. Choose order TOOLS->MACRO->VISUAL BASIC 
EDITOR then INSERT->MODULE. In the workbook activity 
is insert a piece whose default name is MODULE. It  is a 
worksheet   VISUAL BASIC spreadsheets and varies both by 
structure and by commands from the menu bar.  

 

 

Figure 35. MACRO 1 

 

XI. CREATING GRAPHS, DRAWING AND 

SUGGESTIVE PRESENTATIONS 

By creating graphs, drawings and presentations suggestive 
we can achieve the following goals: 

1. ChartWizard use facility to plot the data in a 
spreadsheet; 

2. Edit and Change the appearance of graphs; 

3. Understanding of related references for the data series; 

4. Auto-Formats-Application facility to achieve Charts; 

5. Creating a new default chart; 

6.Use drawing tools; 

7.Slides nurse-use program to make a visual presentation on 
the computer screen;Graphs are more appealing than numbers. 
Making graphs is easy because there is a type facilitated 
Wizard in Excel which fulfills this. Simply enter text and you 
are ready for a presentation on your computer suggestive. 

SELECTING DATA FROM ACHIEVING GRAPHICS 

The facility ChartWizard in Excel, transpose data from a 
spreadsheet into a graph is reduced to making clicks. 
Competency test for you is selecting data. You must understand 
and correctly formulate the message content translated into 
graphic data. Noted that despite the large amount of 
information embedded ChartWizard Facility is unable to 
determine which of the data in the spreadsheet will be 
significant in a graph. This is where your solution. Usually, 
entering all data in a single chart will cause confusion among 
those who will see it as it may contain too much information.  

Instead, you have to select several rows or columns that 
contain significant milestones, report basic and fundamental 
relationships. 

Called the data series or data set a row or a column 
containing numbers required to realize a graph. Purpose of 
tracing a graph using data sets consists usually in out of a 
particular developments or trends data, such as sales growth 
and increased market value of the shares. 

In the jargon of statisticians, it is  to achieve a schedule for 
data reduction. In other words, a well-designed graphic will 
synthesize visual data. 

In order to reduce the idea, here‟s a simple suggestion for 
those who made graphic: Graphic conceive as simple! 

Simplicity can be achieved by a graph represents to a 
businessman, a powerful tool. In presenting a business goal is 
to convince its profitability. If you are unsure of the outcome, 
better postpone is to convince its profitability. If you are unsure 
of the outcome, better postpone the presentation. The idea 
should be to guide you is to use graphs to illustrate your 
findings to apply for a initiating a debate. So if you choose the 
spreadsheet that data will illustrate most clearly conclusions 
can leave ChartWizard can facilitates to portray them as 
attractive.  

Plotting a graph with facility ChartWizard. Here is an 
overview of the process of creating a chart in Excel: 

1. Select your spreadsheet for presentation to which you 
wish to draw the graph. Include columns or rows that contain 
numeric values as those titles and text columns or rows.‟ 

1.Click the button ChartWizard which is found in the 
Standard Toolbar ( above ). 

2.The pointer will turn into a fine result. Mark rectangular 
area that will contain the chart. 

3.ChartWizard will present different options in a series of 
dialog boxes. Answer questions from Wizard ( usually this is 
done clicking on a thumbnail sketch of the desired options). 
After the selection in each dialog box, click the NEXT button. 
To create a default schedule, click the FINISH button in the 
dialog box and skip these steps Step1. 

4. After the selections last dialog box, click Finish. 

In Excel you can create charts and graphs for visual display 
of data. Although many types of charts can be created by small 
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data sets, diagrams are especially useful for presenting and 
summarizing large amounts of data.  

A diagram is a floating object. Thus, you can move 
anywhere you want in the worksheet or change its size by 
dragging a corner. It  can customize almost any part of a chart, 
such as title, axis, labels, legend, of the chart background. 

You may also choose and which optional elements are 
displayed and which are hidden, such as data labels, grids, even 
the data itself.  

Finally if you are not satisfied with the current style  of the 
chart have all the freedom to replace it with another version or 
a completely different charts. 

Excel chart tools are used for creating graphics in Power 
Point and Word. Graphs in Word or Power Point documents 
can be integrated (stable objects that are not related to the data 
in the worksheet) or related (items that are related to data and 
automatically reflect changes made to them). 

ELEMENTS OF THE DIAGRAM 

     A diagram elements can be added or removed easily can 
move new positions. Charts can be resized, it can alter the 
shape and format. (It can also accept default formatting and 
used items present in a newly created chart, but it might not 
happen two often that).Because you spend so much time 
working on the diagram elements it is important for you to 
identify each item. Note that many items listed are optional.  

 

Figure 36. Diagram 

CREATE A CHART 

 

In many cases creating a diagram is a simple, selecting data 
labels and worksheet, and then choose a type of diagram. Chart 
data can be arranged in rows or columns. However, for certain 
types of diagrams, columns and rows must be in a certain order. 

1.If necessary, rearrange the data to match the demands 
diagram. For example, to create a stock chart, your data must 
have order, High, Low, Close. For other requests of the Chart, 
see Create a Chart in Excel Help. 

2.Optional: Arrange the data to ensure that it will appear in 
the desired order when placed in the diagram. 

3.On the worksheet, select labels and data to be created 
chart. Note that labels and data should not be related. 

4.On the Insert tab, choose a chart type from the Charts 
Menu Group symbol. The new chart will appear on the 
worksheet. 

Advices: If you choose the making area of the chart, labels and 
data used to create the chart are highlighted on the worksheet. 
You can also SELECT data by switching the DESIGN TAB by 
clicking on the icon and select the data from the group date. 

To change the type or style of the chart, select the chart, click 
the Design TAB and then Change Chart Type Group.  

 

Figure 37. Format Chart 

 

In the article “Polynomial  Trendline function flaws  in 
Microsoft Excel” by Bruce Hargreaves and Thomas 
McWilliams “Numerous statistical and graphical problems 
have been reported for different versions of Microsoft Excel, 
including the newest version(Excel 2007). We report newly 
discovered problems with Excel 2007 when generating 
polynomial trend line equations, having a user specified 
(forced) intercept, from graphed data. We also remind users of 
Excel‟s Trendline function of problems with Excel 2003that 
have not been corrected in Excel 2007. Excel will “fit” 
nonsense trend lines to data presented on column and line 
charts, and can report an inadequate number of significant 
digits for polynomial trend lines. We provide suggestions for 
avoiding these continuing problems, but are unable to identify 
an Excel 2007 workaround solution for the forced-intercept 
polynomial trend lines errors.” [4] 

ADDING AND FORMATTING TEXT 

      Although primarily visual in nature, charts can contain a 
significant amount of text. Text can be included in a diagram 
contains the title, legend, scale divisions labels, axis labels data 
labels and text boxes. 

To add text to a diagram: 

1. Select chart. 

2. Select one of the following options: 

       Adding a chart title. Switch to the Layout tab, click Chart 
Title (title diagram), the group labels and choose an option 
from the top-down menu. 
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      Adding an axis title.  Switch to the Layout Tab, click Axis 
Titles in the Labels Group and choose an option from the 
submenu Horizontal Axis Title (Horizontal or vertical axis 
Title). 

       Labeling data-switch to the Layout Tab, click the Data 
Table, the group Labels and Choose  show from the MENU 
appearing. Labeling options vary depending on the chart type. 

      Data display chart-Switch to the Layout tab, click the  Data 
Table Labels group and choose Show from the menu 
appearing. 

     Through these chart data will be displayed in a grid in the 
drawing area. 

     Adding another text Switch to the Layout tab, click Axis 
Titles in the Labels group and choose an option from the 
submenu Horizontal Axil Title (horizontal or vertical axis 
Title) or vertical Axis Title (vertical axis title). 

     Labeling title-switch to Layout Tab, click the Data Table, 
the group Labels and Choose Show from the menu appearing. 
Labeling options vary depending on the chart type. 

     Data display Switch to the Layout Tab, click the Data Table 
Labels group and choose Show from the menu appearing. 
Through these chart data will be displayed in a grid in the 
drawing area.  

    Adding another text. Switch to the Layout tab and click the 
Text Box from the Insert group. Click and drag to create a text 
box in the diagram and then write or add text in the text box. 

TO FORMAT THE TEXT DIAGRAM 

1.Select the text object, such as title, legend, axis labels, 
axis labels vertical or horizontal data. (Select an object you 
want to apply the same formatting to the entire text of the 
object). In the text object, select specific text to be formatted. 
(Only certain items of chart permit, such as title, axis label or 
text box). 

1. Do one of the following: 

-home tab, choose the formatting options in the Font group; 

-right-click on the selected object or text , choose FONT 
instant menu, select FORMAT FONT dialog box and click OK; 

-the selected text, move the cursor up and choose 
formatting options minibar instruments; 

-format tab, choose WordArt Style Group Advice; 

To remove must objects, select it and press Del. You can 
switch to the Layout tab, click the appropriate icon and choose 
None Labels group; 

ROWS VERSUS COLUMNS: 

Regardless of how the data is organized in the worksheet, 
you can order the rows and columns. In many types of 
diagrams, layout data in the both forms can offer a new 
perspective on them. 

Switching between rows and columns; 

1. Select chart; 

2. Design tab, click the icon Switch Row/Colum, the 
group data; 

Diagram is replaced to reflect the changes. 

CHANGE THE DISPLAY AND STYLE 

One of the easiest ways to change a chart is to provide a 
new presentation or style. Displaying refers to items that appear 
on the diagram and their position. Style is color chart elements, 
including data objects, backgrounds and background areas 
surrounding plotting. To specify a new view: 

1. Selecting a table. 

2. Design tab, click a symbol of gallery Chart Layouts 
group. Diagram is modified to match the new display.  

3. If the diagram previously undefined text elements 
appear (such as title or axis title), delete them or 
replace them text. 

To change the Chart Style: 

1. Select chart. 

2. Design tab, select a new style from the Chart Styles 
group gallery. 

Diagram is modified to fit her style.  

Advice: 

If you have already added an item (such as a chart title), but 
have chosen a display without that element is not deleted. If 
you later choose a display type that includes the item, it will 
reappear. 

Choosing a new style diagram is a destructive process. 
Items you have formatted like certain colors or background 
grids are replaced with characteristic style.  

 

DISPLAY DATA SET: 

If a chart is based on a small set data may be information 
to present the data table in the diagram.  

To display data in chart: 

1. Select chart. 

2. Fact one: On the Layout tab, select the data display, 
the group data. Design tab, select a display mode from 
the Chart Layouts group that includes data table. 

Data table is positioned in the diagram.  

Advice: 

USING GRIDS 

Easier to estimate the size of data points, you can display 
vertical lines and / or horizontal, called grids, multiple chart 
types. 

You can modify grids by removing their scales in order to 
display large, small or both types for any of the axes and 
specify a color and a new type grids lines. 

ADDING, REMOVING OR CHANGING SCHEDULES: 

     1.Select the table. 

     2. Layout tab, click Gridlines symbol (grid) Axes group and 
choose one of these options, the submenus Primary Horizontal 
Gridlines, Primary Vertical Gridlines or Depth 
None.  

     Eliminate all grid lines of the selected type. 
Broadly grid. Displaying data on a large divisions chosen axis, 
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such as 1-5 or set of numbers divided by 5, 10 or 25 (depending 
on the size and scope of data). 

Small grid lines: 

     Displaying large scale subdivisions of the lines (whether 
large grid lines are visible or not). 

Grid lines large and small: 

     Display both the grid lines large and small for the chosen 
axis. 

     More primary options for grid lines: 

     Open the Format dialog box, where you can set the line 
color, style or shade. 
Select the new setting and click Close. 
The option chosen is applied to the chart. 
 

Advices: 

Depth Gridlines submenu (deep lines) appears only when 
the selected recipes dimensional diagram. 

      Lines can be deleted by right clicking on them and selecting 
Delete from the menu appearing 

 

 

USING LEGEND: 

   If you select a row or a column label to create a chart, it is 
added, most times, a legend. You can add or remove legend, 
to clarify its position according to the diagram, let's change 
the properties (such as fill color and border style) and edit 
tags. 
 
FOR ADDING, REMOVING OR CHANGING CAPTIONS: 
 
   1.Select chart. 

 
   2.Choose one of the following: 

 
   To add, delete or change the position of a legend, click the 
Layout tab and choose an option from the Legend Labels 
group.To manually change the size or position of the legend, 
drag an edge or center. 

 
   To format a legend, right-click it, choose Format Legend 
(formatting legend) appeared menu and make the desired 
changes in the Format Legend dialog box. 
   To change the characteristics of a data series only, select 
that item from the legend, right-click it, choose Format Data 
Series or Format Legend Entry and make the desired changes 
in the related dialog boxes. 
   To change the text used for data entered into legend, make 
edits in the cells you have used that tag. 

ADVICE: 

     You do not have to immediately close the Format dialog 
box. To format an element of the chart, select the item in the 
diagram. Formats dialog box to modify the selected item. 

 

ESTIMATION ADD A LINE 
 

If data is added over time, you can add a line diagram 
(called estimation) to encompass data and predict future values. 
Depending on the dataset, different lines may corresponds 
better data estimates. 

 
 

TO ADD ESTIMATED LINES: 
 

Select chart. 

2. Layout tab click on the symbol Trendline, Analysis 
group and choose an option from the drop-down menu. 
If the chart contains multiple data series, you will see a dialog 
box Add Trendline (add line estimated). 
Select a range of data to be applied on line and click OK. 
Estimated line will appear on the diagram. 

 

3. Optional. 

To change characteristics or model of a line, select it by 
pressing on one of the ends. Open the Format Trendline dialog 
box by one of the following methods: 
 
     -Right click and choose Format Trendline estimated line. 

 
     -Select More Options from the menu Trendline Trendline 
place. Make the desired changes and click Close. The new 
changes will be seen in the diagram. 
 
 
    ADVICES: 
 
    Adding lines estimate is cumulative, i.e.  you can draw 
multiple lines on the same chart. 

    To remove all lines in the diagram prediction, choose None 
(none), Trendline menu. To remove a line (when multiple lines 
are displayed), select the line in the diagram prediction and 
press Del. 

 
   Discover the rest of the options in the Analysis group: 

 
   -Lines: display high-low markers (useful  used for  stock 
charts) and / or drop lines that extend to the X axis of each data 
point. 
 
    Error-bars: Frame with bar each data point representing a 
confidence interval based on a fixed amount, percentage, 
standard deviation, standard error, or a custom formula. 

    In the summary and conclusions of article “Polynomial 

Trendline function flaws in Microsoft Excel” by Bruce R. 

Hargreaves, Thomas P. McWilliams are presented “a variety 

of problems with Excel‟s Trendline function. When working 

with scatterplots and fitting forced-intercept polynomial trend 

lines of degree three to six, the primary problem is that the 

displayed equation is invariably incorrect. Other problems 

include missing terms in the displayed equation and erratic 

behavior when changing the order of the polynomial or when 

closing and re-opening the Excel file. For scatterplot Trendline 
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function fits, regardless of whether the value of the intercept is 

fixed, the equation may be displayed with an insufficient 

number of significant digits. We also show that the use of 

Trendline function when working with column or line charts 

yields results that are clearly meaningless or possibly results 

that appear meaningful but are in fact incorrect. Consistent 

with the results reported by McCullough et al. (2008) , it is 

apparent that Microsoft‟s tradition of providing customers 

with software that is clearly flawed continues with Excel 2007. 

Postcript 

During the second review cycle of this article, a referee was 

unable to replicate the problems we observed with the forced-

intercept polynomial regression fits. We investigated and 

learned that the installation of The 2007 Microsoft Office 

Suite Service Pack 2(SP2), which was originally published by 

Microsoft on April 24, 2009, corrects the problems associated 

with the highest order regression coefficient. The  2R  

calculation inconsistency between the Trendline function and 

other Excel regression-based functions is still present. 

Microsoft is hardly forthcoming with the information that the 

forced-intercept Trendline function yielded incorrect results 

prior to installation of the service pack, and that this problem 

has been corrected. An overview of “improvements”, which is 

apparently a Microsoft pseudonym for “corrected bugs”, 

contained in the service pack was obtained at 

http://support.microsoft.com/kb/953195 and contains no 

reference to the Trendline function. In a more detailed list of 

improvements or corrections, which can be downloaded from 

that website, the trendline-related problems addressed by the 

service pack ar described as “For charts with a trendline that 

has specific data, the first argument of the trendline is 

sometimes calculated incorrectly” and “For charts with 

polynomial trendlines, the first coefficient of the polynomial 

trendline equation is not being considered.” These too-brief 

decsriptions of the problems give no information to a user of 

the Trendline function regarding what results that may have 

been generated in the past can be relied upon, versus what 

results were incorrect and should be recalculated. 

The Microsoft list includes 256 other Excel problems that have 

ostensibly been corrected by this service pack. Examples 

include: 

The Moving Average Trendlines are not being drawn correctly 

for charts when they are based on data that contains #N/A  or 

blank values. 

In Excel, elbow or curved connectors can be printed as a 

straight line. 

In certain workbooks, formulas would not recalculate despite 

the workbook being in automatic calculation mode. 

Bar and Column charts that have some very small positive 

values relative to other values may appear as very small 

negative values. 

This all serves to underscore the concerns raised by 

McCullough (2000) regarding commercial computational 

software in general, and by Yalta and Jenal (2008) regarding 

XLSTAT, a set of non-Microsoft commercial add-in programs 

for Excel that commercial regarding Microsoft‟s apparent lack 

of commitment to quality assurance in business software: “It is 

difficult not to think that if Microsoft‟s apparent lack of 

commitment to quality assurance in business software:” It is 

difficult not to think that if Microsoft tested business software 

the way it tested game software, then the statistical functions 

in Excel would be as accurate as those found in any other 

major software package.” We can only speculate regarding 

how many undetected or detected but unfixed errors remain in 

Excel 2007, or how many new errors have been created by 

Microsoft Office Suite Service Pack 2.” [4] 

 

 

MODIFICATION AXES: 

 

   Most charts have a horizontal axis (x) and vertical (Y). You 

can change any of these to change the label or format. 

 

 

 

TO CHANGE THE AXES: 

 

   1. Select chart. 

 

   2. Select one: 

 

   To remove an axis, Y axis positive stability or precision 

digital units to be used for X axis, click the Layout tab and 

select a menu option held Axes (Axis) Axes group. 

 
   If you want to change the formatting for axis, right-click the 

chart axis label and select Format Axis option or More (axis 

name) Axis Options (several options for axis).  

 

   Make the desired changes in the Format Axis dialog box and 

click Close. 

 

   To change an axis label, edit the label text in the box to the 

worksheet. You can also change the label in the Select Data 

Source dialog box (select data source). Click on the Design tab 

and click the Select Date icon (select dates) group Data. 

 

CHANGING CHART DATA 

 

    Even if you have created a chart and format it carefully, just 

as you sometimes can cause problems.  You can change the 

data that is based diagram! A column or row in the data source 

requires deletion, data from one or more cells to be modified 

or want to add additional rows or columns. 

 

   To change the data in the chart: 

 

   1.Select chart. 

 

   2. Select an option below: 

 

   If you edit the data in the cells is based on the chart, it 

automatically renews to play the edited data. 

 

   Deleting rows or columns 

 

   If you delete rows or columns within the zone used to create 

the chart, the data is automatically removed from the chart. 

 

 

 

ADDING ROWS OR NEW COLUMNS: 

 

http://support.microsoft.com/kb/953195
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   Adding new columns, rows or even in the area of chart-

original data will not trigger a renewal of diagram .For  adding 

new data in the chart, switch to the Design tab and click the 

Select Date icon in the group date. It will appear Select Data 

Source dialog box (select data source). Edit or areas in the 

dialog box select areas new worksheet. Click OK to close the 

dialog box. 

 

   To change the formatting for axis, right-click the chart axis 

label and select Format Axis option or More (axis name) Axis 

Options (several options for axis).  

 

   Make the desired changes in the Format Axis dialog box and 

click Close. 

To change an axis label, edit the label text in the box to the 

worksheet. You can also change the label in the Select Data 

Source dialog box (select data source). Click on the Design tab 

and click the Select Date icon (select dates) group Data. 

 

XII. OTHER FEATURES OFFERED BY MICROSOFT 

EXCEL 

 

 

1.GROUP DATA BY GENERATING TOTALS: 

 

In Excel is possible by organizing and synthesizing 

information on levels of grouping them, then you can operate 

various calculations on these levels or centralized information 

such as totals and subtotals generation. 

To group data that need to be aggregated is necessary 

sorting headings. Sorting is done using other features offered 

by Microsoft Excel: 

 

1. GROUP DATA BY GENERATING TOTALS 

 

In Excel is possible by organizing and synthesizing 

information on levels of grouping them, then you can operate 

various calculations on these levels or centralized information 

such as totals and subtotals generation. 

To group data that need to be aggregated is necessary sorting 

grouping headings. Sorting is done using the SORT command 

from the Data menu. In the dialog box specifies offered keys 

to sort by SORT BY option (Then By) and sort order: 

ASCENDING   or DESCENDING. 

After the data has been sorted by the sort key selected, they 

can be aggregated in cluster fields. 

Subtotal is done by positioning the first cell in that table (or 

selected) and the activation dialog box DATA->Subtotal, they 

specify: 

1.Rubric for which the group or where there is “breaking the 

sequence” at Each Change dropdown list; 

1. The type of surgery that will apply grouped data ( 

SUM, MAX, MIN, AVERAGE, COUNT, 

PRODUCT) of the box USE Function; 

2. Calculated column by selecting it from the Add 

Subtotal to; 

3. After specifying these elements are validated with 

OK; 

 

The total result of the group and will be displayed, 

resulting in changes in meaning spreadsheet occurrence of 

elements (-) signifying the degree of clustering of the 

data. This makes the ranking table.  

Hierarchy allows selecting data items grouped for 

viewing or for further processing such as graphical 

representations of the structure of the required information 

so that the user needs to be emphasized. 

Display hierarchy level: 

-Only totals (Grand Totals); 

-Subtotals (Intermediate tools) and overall total; 

-Items totaling, Subtotals and grand total; 

Return hierarchical display of form is done by 

selecting the table or by positioning the first cell and 

activate command DATA-.SUBTOTALS and 

SUBTOTAL dialog box, select the REMOVE ALL 

button. 

 

I have the following example: 

 
 

 
Figure 38. Marks, Employee, Name, Compartment and Salary 

 

Figure 39. Grouping data 

XIII. FORMS 

A form is a dialog box where you can enter rows of 
information called records in list with these records be 
various operations, location, delete, change. A list is a 
group of rows that contain data are in a relationship. Lists 
can be used as a database in which rows are records and 
columns fields. 

ADD A RECORD IN A LIST USING A FORM 

A form is a dialog box where you can enter rows of 
information called records in list. With these records can 
be various operations, location, delete, change. A list is a 
group of rows that contain data that are in a relationship. 
Lists can be used as a database in which rows are records 
and columns fields. 
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ADD A RECORD IN A LIST USING A FORM 

To add a new record in a list of the following steps: 

1. Select the cell in the list that follows to enter data. 

2. Select the menu Data->Form, click new record. 

3. Insert new record. 

4. To add entry in the list, press the ENTER key. 

5. After all records have been entered, close the 
form using the Close button. 

From the same menu, Data-Form can delete, modify 
on locate records in the list.  

RETRIEVE DATA FROM A LIST 

Data from a list can be so arranged as to highlight the 
rows/ records that meet certain conditions, possible with 
AutoFilter or AdvancedFilter orders. 

USING FILTERS 

 

Filters can bot be applied at a time than a single list, as 
follows: 

1. Select a cell in the list to be filtered. 

2. Select the menu Data->Filter->Auto Filter. 

3. To display only those records that contain a certain 
value, select the appropriate arrow spine that contains  

The desired data. 

4. Select the value. 

5. To include a new condition, based on a value in 
another column, repeat step 3 and 4 in the desired 
column. 

6. To filter a list by 2 values in the same column or tu 
use other comparison operators besides equality in the 
arrow in the column and then select CUSTOM button.  

 

 

CREATE A FORM 

A spreadsheet can be converted into a form if I add 
buttons, labels and other controls available in the task bar 
Forms. While there are some predefined layouts? (Spreadsheet 
Solutions),which are based on common accounting 
applications. 

The steps to create a form: 

1. Select the New option from the File menu. 

2. The spreadsheet formats as needed . 

3. The calculation sheet formats as needed . 

4. To add controls using Formats taskbar. 

5. Can validate form fields, in the same way that 
validates the spreadsheet cells( option Data-
>Validation). 

6. Unused spreadsheet file does fade. 

7. Save the form using the SAVE AS from the FILE 
menu. 

In terms of formatting the worksheet 

You can have the following options: 

-to restrict the access to fields:- can limit user access to 
certain fields in a form. This is achieved by disabling the 
Locked option in the Format –Cells-Protection for fields. 

Then select the submenu Tools->Protection-Protection 
Sheet. Inclusion of formats may be included in the formulation 
and formula of totals or other values. 

This use macros, the macros can assign to buttons on a 
form, that lead to the automatic filling of fields according to 
others or to process the data in some way. 

XIII. WHAT IF ANALYSIS SCENARIOS 

 
What If-Analysis can be done using three facilities offered 

by Microsoft Excel data tables, scenarios and Solver. 

Scenarios are used to compare some values that generate 
different results. This can model various strategies to analyze 
the advantages and disadvantages of different approaches to 
data problems. Scenarios are simulations of several variants of 
the project, which by hypothesis proposed by different values 
of some parameters lead to different results. With this tool you 
can view and analyze assumptions considered. 
Generating scenarios is possible via the menu Data-> What if 
Analysis. 

To effectively build a scenario to select certain cells that 
contain values change (Changing Cells). Participating in the 
formation of the final result and admit that during the 
simulation generates different types of results. 
Preferably before building scenarios cells modifiable called. 
Changing cells should not contain formulas, only constants 
leading to the simulated results. 
Management scenarios is achieved through "scenario 
manager". (Scenario Manager) 
Steps: 

1) previously stated changing cells that participate in the 
simulation (command Insert-> Name-> Define); 

2) is selected by changing cells that contained values lead to 
results in simulation  
scenarios manager activates the command Data-> What-if 
Analysis> Scenario Manager; 

3) Enter the simulation variants (by example: Optimist 
Budget and pessimistic budget) box by clicking Add Scenario 
Manager; 

4) In the Add Scenario insert name box in box scenario 
Scenario name box; 

5) adresses the changing cells box Changing cells box or 
you can insert comments relating to various studies, then 
validate with OK button option; 

6) Enter the appropriate values Scenario Values box 
optimistic scenario; 

7) Press the Add button to enter another scenario 
(pessimistic) or press OK and you are returned to the manager 
of scenarios; 
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8) Place the second scenario (pessimistic) by typing its 
name in the box and completing the Add Scenario values 
changing cells in Scenario Values box. 

9) Return the scenario manager is via the OK button and 
adding new variants operating budget through the Add button. 

10) The Scenario Manager can view the possible 
alternatives scenario simulated by selecting from the list of 
options that the entry scenarios and show activation button 
(action illustrated). Also on this level are subject to change or 
delete scenarios, selecting that option and pressing the Edit ... 
or Delete as appropriate. 

If you want to make a summary of budget alternatives 
simulated, one can generate a report of scenarios. In the 
Scenario Manager dialog box by Merge button ... 
Merge Scenarios dialog box to identify several scenarios in 
Excel documents (Box Book) and multiple spreadsheets, the 
Sheet list box. 

After being constructed a scenario, it can be operated and 
updated by the command Tools-> script. 

To develop a budget incomes are not known precisely. It 
will then consider various values for revenues and will be 
developed for each.  

 

Figure 40. Initial data for incomes, spendings and profits 

 

1.The simulation scenario is possible situations that are 
reflected through several values that can take a cell. Through 
this tool the user testing and verifying hypothesis reading 
various results that have values in a crowd. Number of the set 
determines the number of the cases that are assigned scripts. 

To check the outcome of a hypothesis, the user must go 
through the following steps: 

1. Selecting an existing scenario; 

 

2. Changing an existing script by defining/removing 
variables considered or by changing its value; 

 
 

3. Adding a new scenario; 

 

4. Setting script name, allows rapid identification 
thereof; 

 

 

5. Define the list of variables that will take new values as 
working hypothesis, you can select multiple cells 
using the Ctrl key and mouse; 

 

6. Scenario description for use at an earlier date; 

 
 

7. Defining hypothesis tested by setting new values for 
selected variables; 

 
8. Running script, variables selected in step 5 will get 
new values and initial situation is thus replaced with this 
hypothesis; 

 
10. Defining hypothesis tested by setting new values for 
selected variables; 

 
11. Running script, variables selected in step 5 will get 
new values and initial situation so replaced with this 
hypothesis; 

 
12. Generate a summary of the scenario, visualize new 
results without affecting the current situation; 
If the new hypothesis Optimistic Scenario is based on total 
ticket sales, the sales tabulation is given by generating 
abstract scenario: 

 

Figure 41. Scenarios with Item number, Cinema Hall 
Name, Number of Tikets Sold, /ticket Price and Total Ticket 
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Figure 42. The optimist resulted scenario 

XIV. WHAT IF ANALYSIS GOAL SEEK 

 

When I know the result of a formula, but not the initial 
value of a variable it is uses the facility Goal Seek, from menu 
Data->What If Analysis: 

Steps: 

1. Select the option Data->What If Analysis->Goal Seek. 

2. The box Set Cell it contains the reference of a cell that 
contains the formula. 

3. In the box To Value it introduces the desired value for 
formula. 

4. In the box By Changing Cells it introduces the references 
of cells that contain the adjusted values. 

In the next example I search the rate of interest for that the 
month rate of profitability of a loan is 900$. 

 

Figure 43. Initial data for Goal Seek 

 

Figure 44. The results of Goal Seek 
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XIV. WHAT IF ANALYSIS -SOLVER 

   In the case that the result of a formula depends of a lot of 
variables it utilizes the facility Solver from menu Data->What 
If Analysis, that will adjust the values from the selected cells 
until will obtain the specified result. 

   Solver or the “resolver of the problems” represents an 
information result of optimization that generalizes the 
technique of the value like objective, offering a lot of 
possibilities of simulation of the parameters that generates of 
optimal situations. 

   Like principle, a problem of optimization treated under Excel 
has like target the automation of an application of linear 
programming (SIMPLEX algorithm) having like target an 
optimal solution   in the sense of maximization of efforts or 
setting a target of a value-objective considered by the user.  

    Setting the optimal situation is made through the automated 
update of parameters that lead to the objective proposed, in 
conditions of saying the restrictions imposed by the model, so 
that the optimal situation will take into account these 
restrictions. 

 

 

 

      Example: 

The commercial society IMPEX S.A. wants to optimize the 
global profitability in the sense of maximization of this.  

IMPEX SA Trade company wants to optimize their overall 
profitability in terms of maximizing it. The company manages 
the budgets of three sections, namely: ammonia, nitric acid and 
sulfuric acid. 

  Each department has its own budget forecast, estimating 
revenues, expenses, profit and gross margin eventual outcome 
of the result. Parallel, prospective data are centralized at the 
corporate level, calculating total cost. Economic model to be 
optimized by maximizing shown in the following figure: 

 

 

Figure 45 The initial Solver 

 

Figure 46. Initial Solver with Formulas 

 

   Modifying certain parameters (product number salary per 
hour, unit cost of production factor, the quantity of inputs to 
product) via the formulas presented can generate different 
results for both the cost of each product and the overall 
profitability of the company. 

   Optimization model involves the first of its purpose, if it's 
overall profitability cell containing the formula (Target Cell), 
namely E15 (= Return on total global gross margin rate / 
turnover). 

  To solve the optimization problem in terms of maximizing 
profitability (gross margin rate) positions the cursor on the cell 
containing the target (E15) and activates command Data-> 
Solver and Solver Parameters in the dialog box, shown in the 
following figure are set: target cell, optimization purposes, or 
adjustable changing cells (shown in the previous figure: B3: 
D6) and restrictions on the model. 
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Figure 47. Solver Parameters 

Significance Solver Parameters dialog boxes is as follows: 

Set Target Cell: specify the address of the cell that contains 
the purpose or objective optimization: 

Equal To: Make sense optimization as intended, as follows: 
maximize (Max), minimization (Min) or to reach a value 
(Value of); 

By Changing Cells, suggests that not all cells contain 
formulas and are related to optimization. Ie automatically 
selects all cells that contain numerical parameters that formula 
field that defines the target (Target Cell) refers; 

Subject to the Constraints: contains all restrictions 
optimization model; 

Add button allows you to add restrictions; 

Change button allows you to modify restrictions; 

Delete button allows removing restrictions; 

Solve button launches the process of solving the problem-
solving; 

Options button displays a dialog box in which you can 
control advanced solving characteristics and recording changes 
or specifications for a particular problem, Reset All cancels and 
restores the default parameters assigned. 

After completing elements Solver Parameters dialog box 
and clicking Solve button, it triggers iterative optimization 
procedure, is generated when the problem was finally found (or 
solution) dialog box optimization results (Solver Results). 

The result of optimization parameters assume or replace old 
with new, found in the optimization process, thus transforming 
existing solution into a new (Keep Solver Solution), or restore 
the original parameters and keeping the old result (Restore 
Original Values). Solution found can be saved in a script (with 
existing ones) by pressing the Save Scenario ... 

Optimization results are shown in the following figure: 

 

Figure 48. Optimization results 

 

 

XVI. PIVOT TABLES 

   Pivot Table, like instrument of decision assistance represents 
a facility through which data from worksheet can be permuted 
to put into evidence new information. 

   Pivot Table is an instrument that permits a very elastic 
association of new records into an interactive manner, fact that 
conduces at regrouping of data and present that facts into 
synthetically mod.  

   Pivot Table it creates by selecting the source of data of 
synthesis and making the following operations: Insert->Pivot 
Table, after that an assistant Pivot Table Wizard coordinates 
the user to follow 4 steps: 

   Step 1: It chooses the source of data for Synthesizing of 
information. From this you can select Microsoft Excel List or 
Database (Excel Table or database). The source of data can be 
selected or we position the cursor in the first cell (A1). 

   Step 2: It validates the source table on the base that it will 
consolidate the pivot table or if the source data was not   
selected previous, this can be selected in this phase by Step 
completion in the option Range (Range:$A$1:$G$14). 

   Step 3: It selects data through which it précises which choice 
will be placed on a row and which on a column. 

   Step 4: It stabilizes the address of the pivot table, if this will 
be placed in a new worksheet, or in the existent worksheet, at 
some address. In this phase, it selects the button Options and 
through the dialog box Pivot Table Options it chooses the name 
of pivot table, making some calculations of total general on the 
columns and rows and saving data with the page of the pivot 
table. 
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Figure 49. Pivot Tables 

   In the article “Utilizing and teaching data tools in Excel for 
exploratory analysis” by Susan W. Palocsay, Ina S. Markham 
and Steven E. Markham  the authors “offer Excel as an 
introductory tool too high and business intelligence (BI) and 
decision support system (DSS) applications. Because it is 
ubiquitous, Excel can be used by all managers and business 
students for exploratory data analysis. We provide three key 
points in this utilization of Microsoft Excel 2003: (1) 
manipulating records using Excel as a database, (2) creating 
PivotTables and PivotCharts using Excel for analysis, and (3) 
importing data using Excel as an automation container. The 
basic skill set defined by the above three items allows users to 
begin to use Excel to its full potential in finding information in 
business data, and it offers a key tool for future research in 
improving the utilization of information across organizations ”. 
[5] 

“While the data tools described” in the article “Utilizing and 
teaching data toolos in Excel for exploratory analysis “have 
been available in Excel for years, it is not clear that they are 
being used as fully as they could be. There is evidence in the 
information systems literature that at least some practitioners 
have been aware of their existence. For example, the 
application of pivot tables to examine a system log file of 
Internet described by Gibbs (2002), stressing its value for ad 
hoc analysis. Dickerson (2005) m wrote that “the often-
neglected Excel pivot table can magically save the day”, after 
working with a sales team to produce reports on critical 
business operations. These tools are frequently referenced in 
reviews of business intelligence software that range from light 
duty packages such as Tableau (Clyman, 2006), with features 
that allow the user to visualize data in more than two 
dimensions using color, shape, size, and time, to more 
sophisticated offerings such as SAP‟s customer relationship 
management module(MacVittie, 2006). The capabilities of 
these software packages are usually explained in terms of 
joining tables in a database or multiple worksheets in a 
workbook, OLAP browsing, filtering data into subsets, 
dragging categorized and numerical quantities into multiple 
dimensions, and performing statistical analyses. The 
elementary features within Excel can replicate most of the 
functionality in these higher end packages at a far lower cost 
per user. 

Practitioners in the accounting and finance business diciplines 
have also recognized the potential benefits using these Excel 
data tools. One of the seven qualities of a good financial 
analyst specified in a list developed by Spiech (2005) is 
proficiency in using spreadsheets and databases to analyze 
information. Spiech  emphasizes the importance of being aware 
of Excel tools and knowing when it is appropriate to apply 

them, with an understanding of pivot tables and query design 
being especially useful. A series of articles in the Journal of 
Accountancy  (Haase, 1999; Lacher, 1998; Lenning, 2000) 
describe the drill-down functionality of pivot tables and the 
process of linking a database to the spreadsheet for financial 
reporting. More recently,, Shumaker(2005) advocates the use 
of Excel data tools for effective use of insurance agency 
technology. The teaching of pivot tables to develop trial 
balances from journal entries, without the need for T-accounts, 
is encouraged by Montondon and Marsh(2006). They point out 
that the use of Excel data tool technology in the classroom can 
eliminate tedious work that students dislike and increase the 
available time to discuss the effects of transactions of financial 
statements. Clearly, there is no reason why the benefits from 
using Excel should be restricted to the accounting and finance 
disciplines. 

Given the widespread problem of data overload in 
organizations, the widespread deployment of Excel, and 
questionable skills levels of current analysts and students, we 
suggest that a detailed exposition of the core functions with 
Excel can be an inmportant factor in improving the usability of 
this information. Thus, a deep analysis of these core skills for 
both researching and teaching Excel seem warranted.”[5]  

XVII. LISTS 

In Excel data can be managed easily if organized as a list. A 
list is an area of a spreadsheet containing similar data. Each 
column represents a specific category from the list of data 
(called fields) and determines the type of information required 
for each entry in the list. Each line in the list is a record. 

To create a list, you need to enter a title for each column. 
Lists can be created in any area of the spreadsheet, just as the 
area below the list does not contain data, so you can extend the 
list without interfering with other data in the spreadsheet. 

To insert records in the list will enter data in lines just 
below the column headings. Each record must contain the same 
fields. The following figure is represented a list that contains 
information about commands delivered by a company 
distributing electronics products at companies of various cities. 
For each command are provided information about the delivery 
date of the order, the product sold, to whom the order was 
delivered, number of pieces delivered and order value. 

To facilitate entering and editing records we can use the 
facility of forms. A form is an organized image data including 
column names, data entry text boxes and buttons for adding, 
deleting and finding records.  

Excel 2010 proposes Data Input Form that helps users fill 
cells more easily.  Enables users to create a Form for entering 
data, which saves a lot of time by providing a simple interface 
in which you can enter the data without hassling of scrolling 
the window and search records for editing. The Data Input 
Format feature lets you fill the cell‟s values of a single record 
quickly. 

The Data Input Feature lets you move through the entered 
data using the next and previous buttons. Easily you can edit 
the data, delete a record and create a new record from within 
the data input form dialog box. 

For instance: If I want to introduce records in a list that 
contains information about the delivered commands by a 
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company distributed of electronics products at companies from 
different cities from countries, we proceed like this: 

I go into File Menu, click Options and in the Left Panel  we 
click Customize Ribbon. In the right Panel we select All 
Commands from Choose Commands from the Drop-Down 
Options and look for Form Command. Now, from Left Panel, 
select HOME and hit NEW GROUP, new group will be added 
to HOME tab, change its name to FORM and then CLICK 
ADD-> button to ADD FORM COMMAND to newly created 
group. Click OK to close Excel Options Dialog. 

EXCEL OPTIONS RIBBON ->ALL COMMANDS -
>FORM->ADD->FORM (CUSTOM) ->OK. 

You will see the FORMAT COMMAND at the end of the 
HOME RIBBON.  

 

Figure 50 Form Picture  

 

If I want to add a new record in my list I follow the next 
steps: 

1. I go into menu New Tab. 

2. I click Form button to open its dialog.  

3. I will populate the form with a new record. 

4. I will start to introduce the following data: Date->15 
Dec 2012; Product->computers; Company: S. C. V3; 
City :Bucharest; No. products: 25; Ordered value: 
375000000.  

 

 

  Figure 51. Introduce data in list  

   Once Form is filled, you can enter records for the other 
products, Click Find Next. 

   Records of all products are populated in a quite simple way, 
as seen in the screenshot below. 

 

Figure 52. Populated list 

   The article  “Validation of lattice code “EXCEL” with TIC 
experiments on uniform and regularly perturbed lattices” tells 
as that “Temporary International Collective(TIC) was 
established in 1972 by an agreement among seven countries, 
namely, Bulgaria, Czechoslovacia, Germany, Hungary, Poland, 
Romania and Union Soviet Socialist Republics. The main 
objective of TIC was to provide the experimental data for the 
reactor physics analysis of water cooled and water moderated 
power reactors (WWER). Extensive experimental work for 
different core configurations was carried out by TIC countries 
to investigate the physics behavior of WWER lattices and the 
results were published in TIC volumes. 

   Two VVER-1000 MWe reactors are currently in an advanced 
stage of construction and due for commissioning in 
Kudankulam, Tamil Nadu, India. Indigenous development of 
in-core fuel management computer codes for the analysis of 
hexagonal lattice cores is also in an advanced stage to address 
various design, operation and safety issues of VVER type 
cores. The validation of the above TIC lattice experiments will 
help in the identification of deficiencies in reactor physics 
design computational codes and the associated nuclear data 
libraries. In this paper, TIC experiments on uniform and 
regularly perturbed lattices have been analyzed as part of the 
validation of indigenous computer codes, EXCEL, TRIHEX-
FA and HEXPIN  developed at Light Water Reactors Physics 
Section, B.A.R.C. Neutron-nuclear multi-group cross-section 
libraries in WIMS/D format in 69/172 energy groups have been 
released by IAEA at the conclusion of WIMS library update 
project (WLUP). In the present study we have used libraries 
based on ENDF/B-6, ENF/B-7, JEFF3.1 and JENDL3.2 
evaluated nuclear datasets. The results of theoretical analyses 
bring out the performance of the code system and various 
cross-section libraries.  “[6] 
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   The conclusions of article “Validation of lattice code 
“EXCEL” with TIC experiments on uniform and regularly 
perturbed lattices”  are: “ The TIC uniform and regularly 
perturbed lattice experiments were analyzed using the 
hexagonal lattice burnup code EXCEL. Four 172 group 
libraries, based on ENDF/B-6, ENDF/B-7, JEFFE3.1 and 
JENDL3.2 datasets were used. In Excel modeling a transport-
diffusion correction was implemented. For this the cross-
sections of the strong absorber cell were modified using a 
diffusion iterative technique (DIT). It is noted that the results of 
the new libraries are improved over that of ENDF/B-6. The 

DIT method also improves the calculated effk  by 6mk. There 

is large the underprediction is due to higher  fast neutron 
leakage for lattices having 11 mm pitch in comparison to the 
lattices having 12.7 mm pitch.  

   Hence, there is a need for 3-D computations for the leakage 
calculations, which are expected to improve the results. The 
relative worth of soluble boron, enrichment and change in pitch 
is predicted to be similar by all libraries. The relative worth of 
various absorbers is predicted well by all libraries after using 
the DIT correction. The comparison with experimental data is 
found to be satisfactory.”[6] 

 

XVIII. CONCLUSIONS 

 

In conclusion in this article I presented all the facilities of 

Microsoft Excel 2010 that are utilized all over the world in the 

all economic activities.  
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